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AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS
1. « GENERAL INFORMATION

The information contained herein, is provided in connection with the usage of hardware and
software of AFJ FFT 3110 and FFT 3100 EMI receivers. Members of the AFJ FFT 3000 family are:

FFT 3010 9 kHz to 30 MHz

FFT 3030 9 kHz to 300 MHz
FFT 3110 9 kHz to 1000 MHz
FFT 3100 30 MHz to 1000 MHz

All information contained herein, is subject to change without prior notice and cannot be
duplicated, copied or reproduced in whole or part, without prior written consent of the owner:

AFJ Instruments, Via Gavirate 16, 20148 — Milan, Italy
Phone: +39 02 91434850

E-mail: sales@afj-instruments.com

Website: www.afj-instruments.com

All efforts have been made to ensure the accuracy of the contents of this document. However, the
supplier can assume no liability whatsoever for any errors in this manual or their consequences,
direct and/or indirect.

2.« SCOPE AND ORGANIZATION OF THE MANUAL

This Manual contains information and procedures required to install and operate the members of the
AFJ FFT 3000 family of EMI Receivers. The contents are generic for all models of Interference
Measuring Receivers: specific paragraphs, or parts thereof, will describe functionalities and operating
modes pertinent to the single models, whenever appropriate.

The manual is divided into six sections as follows:

Section A RF Emission Testing and FFT-Based EMI Receivers
Section B General Information

Section C System Installation

Section D Operating Instruction

Section E Report and Applications Notes

Section F Manual Operations

Section G Troubleshooting

3.« STATEMENT OF COMPLIANCE

The AFJ FFT 3110 and FFT 3100 EMI receivers are designed and built in accordance with CISPR
Publication 16-1-1: “Specification for radio disturbance and immunity measuring apparatus and
methods - Part 1: Radio disturbance and immunity measuring apparatus”.

4. ¢« WARRANTY

Systems, options and accessories thereof, manufactured and shipped under the AFJ Instruments
brand name, are warranted to be free from manufacturing defects for a period of twelve (12) months
from the date of shipment. AFJ Instruments certifies that all products are tested and inspected to
comply with the published specifications originating from the company. Calibration procedure
includes Calculation of uncertainty using 1ISO model and traceability. Warranty is provided “Ex-
Works”: therefore, AFJ Instruments will be responsible of the Amendment of failures arising from
ascertained manufacturing defects only.
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Warranty will not be applicable in case of mishandling, unauthorized opening of the cabinets,
improper use, and unauthorized repairs. In such cases, the warranty will be terminated.

A repair under warranty will not extend the original term of validity of the warranty itself.

All products or parts thereof, to be subject to a warranty operation, shall be shipped to the
appropriate AFJ Instruments Warranty Centre, at Customer’s charge.

If a delivery back to the supplier is necessary, we recommend keeping the original transport case.
In such case, refer to the following Return Procedure.

5. ¢« RETURN PROCEDURE

To return the FFT 3110 and FFT 3100 EMI receivers to AFJ Instruments, use the following procedure:
Briefly describe the problem in writing (Service Requested form). Include the serial number of the
item being returned;

Give details regarding the observed symptom(s), and whether the problem is constant or
intermittent in nature. If you have talked previously to AFJ representative about the problem,
provide such information also;

Package the unit carefully, using the original boxes and packing materials, if possible. If not, use
the most protective envelope at disposal (Damages due to transport are not covered from any
guarantee);

Before return the system back to AFJ, wait for RMA number (Returned Material Authorization).
The SW provided with the systems, is released “as-is” and is not covered by any warranty, not
expressed, nor implied. However, AFJ Instruments is committed to correct, in a reasonable
timeframe, all possible discrepancies reported with respect to the product specifications, through
appropriate SW releases, free-of-charge.

Any changes, additions, extensions of the SW or FW originally supplied, will render the system
warranty invalid.

6.  DISCLAIMER OF LIABILITY

In no event shall AFJ Instruments be held liable for incidental or consequential damages of any kind
whatsoever caused or alleged to be caused directly or indirectly by the usage and operation of
products herein, to customers or any third party, including, but not limited to, loss of use, loss of
profit or any commercial loss. Products described herein, do not imply any stated or alleged fitness
for use, or any feasibility for business purpose, or expectation of profit. AFJ Instruments sole and only
commitment is the compliance with the published product specifications. All information in this
manual is given in good faith. However, AFJ Instruments shall not be liable for any loss or damage
whatsoever arising from the use of this manual, or any errors or omissions herein.

7. « WORKING CONDITIONS

The allowed temperature range during use of the device is +0°C to +45°C. In cases of storage or
transport this range may exceed by -20°C to +70°C.

Working relative humidity shall be 30% to 75%, atmospheric pressure shall be 86kPa to 106kPa (860
to 1060mba). System is not influenced by direct solar radiation.

The EMI receiver is to use in dry and clean rooms. Avoid conditions like dust, air-humidity, danger of
explosion and aggressive chemical environment. During use a sufficient air circulation is to realize. It
is possible that condense water originates inside the device due to storage or transport conditions. In
this case realize a period of 2 hours for acclimatize without use.

Do not cover the ventilation holes. A distance of about 20 cm must be maintained between the rear
panel of FFT 3110 and FFT 3100 and any wall and about 5 cm between the sides of FFT 3110 and FFT
3100 and any other equipment or walls.

NOTICE: FFT 3110 and FFT 3100 EMI receivers are supplied in proper special packaging due to their
heavy weight. We strongly recommend you to save packaging for next transport.
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CE MANUFACTURER DECLARATION OF CONFORMITY

Manufacturer AFJ INSTRUMENTS SRL
Via Gavirate 16
20148 Milano
Italy
Product Types EMI receivers models FFT 3100 and FFT 3110

We hereby declare that the aforementioned equipment complies with the requirements set out in
the Council Directive on the Approximation of the Law of Member States relating to:
- Electromagnetic Compatibility, Directive 2014/30/EC

IEC 61326-1 Electrical equipment for measurement, control and laboratory use - EMC
requirements - Part 1: General requirements

- IEC 61326-1 Class B (Emission)
- IEC 61326-1 (Immunity, laboratory)

- Low Voltage Equipment Directive (2014/35/EC) and EN 61010-1 (“Safety of Electrical
Measuring Apparatus”).
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UKCA MANUFACTURER DECLARATION OF CONFORMITY

Manufacturer AFJ INSTRUMENTS SRL
Via Gavirate 16
20148 Milano
Italy
Product Types EMI receivers models FFT 3100 and FFT 3110

We hereby declare that the aforementioned equipment complies with the relevant requirements of
the below referenced specifications. The unit complies with all applicable essential requirements of
the directives.

Electromagnetic Compatibility Regulations 2016

Electrical Equipment (Safety) Regulations 2016

The Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic
Equipment Regulations 2012

EN 61326-1:2021 Electrical equipment for measurement, control and laboratory use — EMC
requirements - Part 1: General requirements

- EN/IEC 61326-1 Class B (Emission)
- EN/IEC 61326-1 (Immunity, Laboratory)

EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and
laboratory use - Part 1: General requirements
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SECTION A: RF EMISSION TESTING AND FFT-BASED EMI RECEIVERS
A.leEMI

EMI (electromagnetic interference) is the disruption of operation of an electronic device when it is in
the vicinity of an electromagnetic field (EM field) in the radio frequency (RF) spectrum that is caused
by another electronic device.

The internal circuits of personal computers generate EM fields in the RF range. Also, cathode ray
tube (CRT) displays generate EM energy over a wide band of frequencies. These emissions can
interfere with the performance of sensitive wireless receivers nearby. If you have a wireless receiver
of any kind and use it at the same time as you operate your personal computer, you will probably
hear RF noise in the receiver that originates in the PC system.

Moderate or high-powered wireless transmitters can produce EM fields strong enough to upset the
operation of electronic equipment nearby. If you live near a broadcast station or in the downtown
area of a large city, you have probably experienced EMI from radio or television transmitters.
Cordless telephones, home entertainment systems, computers, and certain medical devices can fail
to work properly in the presence of strong RF fields.

Problems with EMI can be minimized by ensuring that all electronic equipment is operated with a
good electrical ground system. In addition, cords and cables connecting the peripherals in an
electronic or computer system should, if possible, be shielded to keep unwanted RF energy from
entering or leaving. Specialized components such as line filters, capacitors, and inductors can be
installed in power cords and interconnecting cables to reduce the EMI susceptibility of some systems.

Radio frequency EMI emission tests are a common feature for EMC compliance of most electronic
and electrical products. The purpose of these tests is not so much to check the operation of the
product, as to ensure the protection of users of the radio spectrum when the product is used in their
neighborhood. All commercial products, including some automotive applications, will be tested
against the CISPR standards.

A.2 ¢ CISPR 16-1-1 INSTRUMENTATION

IEC CISPR publication 16-1-1: “Specification for radio disturbance and immunity measuring apparatus
and methods - Part 1: Radio disturbance and immunity measuring apparatus”, specifies the
characteristics and performance of equipment for measuring EMI in the frequency range 9 kHz to 18
GHz. It includes specifications for:

— The Peak, Quasi Peak, CISPR Average, RMS / CISPR RMS measuring receivers including FFT-
based EMI receivers that can «sample and evaluate the signal continuously during
measurement time» without any blind gap, like FFT 3110 and FFT 3100.

— Absorbing clamps

— Antenna

— Tests Sites

All commercial standards refer to CISPR 16-1-1 systems.
The EMI receiver is the key element of either conducted or radiated emission measurements.
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A.2.1 ¢ CISPR 16-1-1 EMI RECEIVER

The principal measuring receiver CISPR parameters are listed in Table A.1.
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Parameter Frequency Range

9 +150 kHz 0.15 +30 MHz 30+ 1000 MHz 1+ 18 GHz
Quasi Peak
Charge time 45 ms 1ms 1ms Not defined
Discharge time 500 ms 160 ms 550 ms Not defined
Overload factor 24 dB 30dB 43.5dB -
Peak
T Discharge / T Charge 1.89x 104 1.25x 108 1.67 x 107 1.34x 108
General
Bandwidths (-6 dB) 200 Hz 9 kHz 120 kHz 1 MHz
Sine Wave accuracy <+2dB <+2dB <+2dB <+25dB

Table A.1: CISPR 16-1-1 instrumentation characteristics

Traditional EMI receivers are similar to superheterodyne spectrum analysers in all aspects, with
additional features like pre-selector, pre-amplifier and different types of detectors like Peak, Quasi
Peak and Average. The pre-selector consists of an input attenuator and a tunable band pass filter. It
prevents the input mixer of the EMI receiver from overloading and also it improves the dynamic
range. The pre-amplifier is a low noise amplifier, which it is used to improve the sensitivity of the EMI
receiver. The main section of the EMI receiver are the IF filters and the detectors. The main detectors
used for EMC measurements are Peak, Quasi Peak and Average. Peak detector responds
instantaneously to the peak value of the signal and discharges rapidly. The Quasi Peak detector is
nothing but a Peak detector with weighted charge and discharge times, which correct for the
subjective human response to the pulse type interference. The Average detector measurements the
Average value of the signal.

This kind of measurements are very demanding and become very time consuming when large
frequency ranges need to be swept or stepped or small resolution bandwidths are needed to achieve
the necessary sensitivity. So, there was a strong request in reducing measuring time saving accuracy
for this type of test. Besides, there was a felt need for time-domain measurements to evaluate the
duration of discontinuous disturbances.

Both these tasks are now easily and effectively and conveniently performed by the time domain
output of an FFT-based measuring receiver.

A.2.2 ¢ FFT-BASED EMI RECEIVER

The possibility to record the temporal behavior of the signal directly in time domain by the use of fast
ADCs (analog-to-digital converters) and to apply FFT (Fast Fourier Transform) was recently exploited
by International Committees. The application of the FFT can be interpreted as a parallel
implementation of many filters at different frequencies. This technique has been well known for
decades, but the capability of modern ADCs has reached lately a level where the application to EMC
emission measurements becomes feasible.

For CISPR-compliant emission measurements, FFT-based measuring instruments must sample and
evaluate the signal continuously during the measurement time, as we have seen.

This task is the most stringent request for an EMI receiver.

In order to process the signal continuously and to enable the calculation of a real-time spectrogram,
the frequency range from DC to 3 GHz is subdivided into many sub bands with a bandwidth of FFT-
band each. Every sub band is digitally down-converted to the baseband and the sub bands are
processed sequentially. The block diagram is shown in Figure A.2.
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A polyphase decimation filter is used for the in phase and quadrature channel to reduce the sampling
frequency and to fulfill the Nyquist criterion. The output sampling frequency is twice the FFT-band,
while the bandwidth is fixed by the FFT implementation.

Receiver Signal
preselection Wideband reconstruction
and mixer IF filter & weighting

{% MH % ADC FPGA
(Att. + Input preamp)

Main

processor

Fig. A.2: FFT-based EMI receiver block diagram

The following approach was proposed by Braun from the Technical University of Munich. The signal is
digitized continuously by an Analogue-to-Digital Converter System. By a digital down conversion
(DDC) the measured signal is limited in its bandwidth (some dozens of MHz) and the sampling rate is
reduced. After that the data is processed in a continuous way with the STFFT (Short Time Fast Fourier
Transform) algorithm. The evaluation of the obtained spectrogram can be performed at several
frequencies, with a great reduction of the measurement time.

The system needs a digital dedicated hardware.

In the next step, the CISPR-detectors must be modelled. Peak, average and RMS are straight forward
mathematical operations, while the quasi-peak, the RMS-AV, and the CISPR-AV detectors can be
modelled (also as a digital filter to model the instrument time constant). The detailed architecture
diagram is shown in Figure A.3.

Antenna
QkHz — 1.1 GHz Detectors Arnplituce
i STFFT . PEEK Spectmm
oo CQluasi-Pea
= AVErage
I ' RMS
o
oo
LIS i

Fig. A.3: FFT-based EMI receiver architecture diagram
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If an interference signal spectrum is wider than the bandwidth of the instrument which measures it,
then the indicated value will depend on that bandwidth. If it is narrower, then the indicated value is
independent of bandwidth. This is the basis of the distinction between “narrowband” and
“broadband” interference. If you are measuring known radio signals then you can tailor the
measurement bandwidth to the characteristics of the signal, but this is not possible for EMC
measurements, since the characteristic of the interference is almost by definition not known in
advance. Therefore, the measuring receiver specification must include a defined value not only for
the bandwidth, but for the shape of the filter that determines this bandwidth. The CISPR bandwidths
are given in Table A.1. These are bandwidths at which the EMI receiver response is —6dB relative to
the centre frequency.

Only an EMI receiver whose bandwidth characteristics fully comply with this specification should be
used for full compliance measurements. However, if you are only measuring narrowband
interference, such as individual emissions from the harmonics of microprocessor clocks, the actual
performance of the EMI receiver filters will have little or no effect on the outcome. This is the root of
much of the confusion over bandwidth requirements.

A.2.4 e DETECTORS

A.2.3 e BANDWIDTHS

In nature, interference emissions are not continuous at a fixed level. A carrier signal may be
amplitude modulated, and both a carried and the broadband emission may be pulsed.

That is, the measured level indicated for different types of modulation will depend on the type of
detector in use. As a result, EMI receivers should have man-like response built-in: they must have a
Quasi Peak weighting display to show the human perception of interference as a measured value.
CISPR 16-1-1 specifies five principal detector types, Peak, Quasi Peak, CISPR Average, RMS and CISPR
RMS. Radiated emissions limits are usually specified by standards using the Quasi Peak detector.
Conducted emissions limits are specified for the Quasi Peak, the Average and RMS detectors. Full
compliance measurements must use only the correct detectors. The difference between the
detectors resides in how they respond to pulsed or modulated signals. All five types of detector give
the same response to continuous unmodulated signals. The Quasi Peak and Average detectors
weight the indicated value according to its pulse repetition frequency (PRF).

The RMS detector, specified at § 7 of CISPR 16-1-1, indicates a value proportional to the square root
of the PRF: this corresponds to RMS reading increasing by 10 dB when PRF increases by a factor 10 (1
decade), or an increase by 3 dB per octave (factor 2) of the PRF. The Average detector, specified at §
6 of CISPR 16-1-1, indicates a value proportional to the PRF, namely an increase in reading by 20 dB if
the PRF increases by a factor 10 (1 decade), or an increase by 6 dB if the PRF is doubled (octave).

The indicated level of pulsed interference is reduced by the degree in Figure A.4, as a result of the
time constant and bandwidths given in Table A.1.

The Quasi Peak detector weights the indicated value in terms of its perceived “annoyance factor”:
low pulse repetition frequencies (PRF) are less annoying when experienced on broadcast radio and
TV channels than high PRFs. The detector is specified in terms of its attack and decay time constants,
and these are fairly straightforward to implement. The Average detector simply returns the Average
value rather than the peak value of the interference with which it is presented. This can in principle
be achieved with a simple low-pass filter whose time constant is slower than the slowest pulse
repetition frequency of the input. An EMI receiver is calibrated using pulses of defined impulse area,
spectral density and repetition rate.
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Fig. A.4: PRF of PK, QP, RMS and Average detectors in CISPR Band A, B and C/D

Most initial measurements are performed with the Peak detector, which as its name implies
responds almost instantly to the peak value of the interference signal seen at its input. Provided that
the EMI receiver dwell on each frequency for long enough to capture the maximum emission (this
depends on the EUT’s emission cycle time) the Peak detector will always give the maximum output
level. A list of frequencies at which high emission are detected, could be created, and these
frequencies are measured with the requested detectors, which will give the reading which should be
compared against the limit.

As an example, most emission standards follow the simple procedure in Figure A.5.

Peak detactor

Creata table
of frequencies

Peak datedor
Create table
of frequencies

Y N
X result < QP limit - X7,
N
QP detector

Maximize at
each frequency

Y,

result < QP limit?

Conducted emissions Radiated emissions

Fig. A.5: Flow chart for use of detectors
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A.2.5 ¢ OVERLOAD FACTOR

The linear dynamic range of the RF circuits before the detector, and of the detector itself, must be at
least equal to the dynamic range of the desired pulse weighting since the pulses are not to be
compressed. This dynamic range according to the CISPR 16-1-1 specification (see table 1) can
approach up to 43.5 dB, which means closer to 60dB in the EMI receiver design. If the EMI receiver
did not adjust its gain continually to achieve the optimum level at the detector — acting as a spectrum
analyzer, for instance — then the needed dynamic range would be increased by several tens of dB.

A.2.6 * VSWR

Still part of the CISPR 16-1-1 speg, is the requirement on input VSWR (Voltage Standing Wave Ratio).
This is specified to be 2.0:1 with no input attenuation, dropping to 1.2:1 with = 10dB attenuation in
the range 9 kHz to 1 GHz; in the range 1 GHz to 18 GHz to be 3.0:1 with no input attenuation,
dropping to 2.0:1 with = 10dB attenuation. VSWR is related directly to measurement error due to
mismatch. For a broad-spectrum EMI receiver (30MHz to 3GHz is two decades) the spec of 2:1
without attenuation is quite hard to meet — many ordinary radio receivers cannot achieve this even
over a narrow range. It is easy enough if you allow yourself some attenuation at the input, but then
the EMI receiver sensitivity is degraded. The sensitivity requirement in CISPR 16-1-1 is expressed in
the form that the noise component should not degrade the measurement accuracy by more than 1
dB, which implies that the system noise floor must be at least 6 dB below the lowest level it is desired
to measure accurately. The system noise floor is the EMI receiver noise plus the losses imposed by
the transducer or antenna factor and connecting cables. In practice, the limiting performance is
usually found at the top end of the radiated test around 1+3 GHz.

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03
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SECTION B: GENERAL INFORMATION

This Section contains a general description of the FFT 3110 and FFT 3100 EMI receivers, including:
associated and optional accessories, equipment specifications and safety precautions.

REFER TO MANUAL. THIS MANUAL IS AN INTEGRAL PART OF FFT 3110 AND FFT 3100 EMI
RECEIVERS. THE SAFETY RULES AND PRECAUTIONS IN THE MANUAL MUST BE OBSERVED. AFJ
INSTRUMENTS AND THEIR REPRESENTATIVES ACCEPT NO RESPONSIBILITY FOR DAMAGES TO
PERSONS AND EQUIPMENT AS RESULTS OF NON-OBSERVATION OF THE RULES PRECAUTIONS IN
THIS MANUAL.

B.1 ¢« EQUIPMENT DESCRIPTION

FFT 3110 and FFT 3100 are microprocessor-controlled FFT-based EMI receivers covering the
frequency range from 9 kHz/ 30 MHz to 1000 MHz. This instruments are ideally suited for
measurement of electromagnetic interference in accordance with the requirements of CISPR 16-1-1.
The EMI receivers can also be used as selective RF voltmeters with a level range from 10 to
+127 dBuV in 50 Q coaxial systems.

FFT 3110 and FFT 3100 EMI receivers are supplied with the following STANDARD ACCESSORIES:

Description Qty
110/ 230Vac, 50 / 60Hz, 50VA Class | power cord

F 3,15A FUSE

3.5mm (Male) To 2.5mm (Female) stereo audio jack adapter

AFJ EMI Software USB-key (containing: Operating Manual & Operating Software)
Certificate of Calibration

Mouse

Keyboard

Noulbhlw|Nn|-
RiRrR(RR|IN|-

Fig. B.1: AFJ FFT 3110 EMI Receiver

AFJ FFT 3110 AND FFT 3030 EMI RECEIVERS — Operating Manual —rev. 2.8 / 2023-03
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B.2 ¢ USAGE OF EXTERNAL PULSE LIMITER / ATTENUATOR

High spikes produced by either LISN output or power supply transient noises, could damage the input
stage of EMI receiver. FFT 3110 EMI receiver maximum allowed RF input is +127 dBuV in CW 50 Q
coaxial systems.

WE STRONGLY RECOMMEND THE USAGE OF EXTERNAL PAT20M (20dB/1W ATTENUATOR AND PULSE
LIMITER), SUPPLIED OPTIONALLY AND SEPARATELY WITH FFT 3110 EMI RECEIVER.

The PAT20M has been designed to fit between the LISN and the measuring instrument to protect the
instrument from mains transients interface. The LISN itself will attenuate most of the transients on
the mains supply — the real problem is the connection and disconnection of the EUT, which can cause
up to 400V transients to appear at the RF outputs.

WARNING: WHEN USING FFT 3110 EMI RECEIVER WITHOUT PAT20M ATTENUATOR (OR SIMILAR
FIXED ATTENUATORS), ANY DAMAGE AT THE INPUT STAGE OF EMI RECEIVER IS NOT COVERED BY AFJ
WARRANTY.

Fig. B.2: PAT20M 1 W 20 dB attenuator & pulse limiter

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03
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B.3 ¢ PRODUCT STRUCTURE

arF]

The AFJ FFT 3000 family of equipment are FFT-based EMI receivers which makes use of the super
heterodyne approach, converting the RF input signal into an intermediate frequency (IF), before
detection. The main instrument subsystems are:
- The pre-selector filters, tuned on the RF input frequency, to avoid spurious signals;
- The attenuators and Preamplifier, to regulate the input signal;
- The local oscillator, with a frequency lower or higher, with respect to the input signal;
- The mixers, where the input signal and the local signal are intermixed, to generate the IF;
- The ADC converter, to convert analog input signal to digital signal for DSPU;
- The DSPU (Digital Signal Processing Unit), to elaborate the digital input signal giving the output
signal with the basic functions that are processed by SW, providing the experimental values and, if
requested the audio signal (this subsystem includes digital filters and detectors).
The modular approach followed, enables the user to customize the system configuration according
to his specific needs:

— Model FFT 3010, is suitable for measurements across the CISPR 16-1-1 frequency bands A/B,
from 9 kHz to 30 MHz;
— Model FFT 3030, is suitable for measurements across the CISPR 16-1-1 frequency bands
A/B/C from 9 kHz to 300 MHz;
— Model FFT 3110, is suitable for measurements across the CISPR 16-1-1 frequency bands
A/B/C/D from 9 kHz to 1000 MHz;
— Model FFT 3100, is suitable for measurements across the CISPR 16-1-1 frequency bands C/D
from 30 MHz to 1000 MHz.

B.4 ¢ OPTIONAL ACCESSORIES

In order to fulfill all set-up requirements, as specified in the relevant sections of CISPR 16-1-X and the
applicable Product Standards, the following OPTIONAL ACCESSORIES are made available:

ltem Description Order Code
1 20dB/1W Attenuator and pulse limiter PAT20M
2 High voltage probe, 30 dB attenuation TK 9420
3 LISN, 9 kHz to 30 MHz single-phase, 2x16 A LS16C/10
4 LISN, 9 kHz to 30 MHz three-phase, 4x32 A LT32C/10
5 Absorbing clamp, 30 MHz to 1000 MHz (CISPR 14) MDS 21B
6 Large Loop antenna system (LLAS) from 9kHz to 30MHz for VVL 1530
magnetic field measurements (CISPR 15)
7 CDNE from 30 MHz to 300 MHz for radiated emission M2 or M3
measurements (CISPR 15) (for example)
8 Dummy lamps for insertion loss measurement Linear Type
(for example)
9 Balance-to-unbalance  transformer  for  insertion loss BUT
measurement
10  Van Der Hoofden test head from 20kHz to 10MHz for human VDH 30
exposure measurements to electromagnetic fields
11  Broadband antenna, from 30MHz to at least 3000MHz Any brand
12  Near field probes (Large area) Any brand

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03
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B.5 ¢ RELATED DOCUMENTS

The EMI receivers belonging to the AFJ FFT 3000 family described herein, perform electromagnetic
compatibility measurements in the domain of radiated noise, in accordance with (but not limited to)
the following Harmonized European EMC Standards:

CISPR 10

Organization, rules and procedures of the CISPR: Gives the historical background, terms of
reference, composition, organization, and types of documents of the International Special
Committee on Radio Interference (CISPR).

CISPR 11

Industrial, scientific and medical (ISM) radio-frequency equipment - Electromagnetic
disturbance characteristics -Limits and methods of measurement: The limits and methods of
measurement laid down in this International Standard apply to industrial, scientific and medical
(ISM) equipment as defined in clause 2, and to spark erosion equipment.

CISPR 12

Vehicles, motorboats and spark-ignited engine-driven devices - Radio disturbance
characteristics -Limits and methods of measurement: The limits in this standard are designed to
provide protection for broadcast receivers in the frequency range of 30 MHz to 1000 MHz when
used in a residential environment. Compliance with this standard may not provide adequate
protection for new types of radio transmissions or receivers used in the residential environment
nearer than 10 m to the vehicle, boat or device

CISPR 13

Sound and television broadcast receivers and associated equipment - Radio disturbance
characteristics - Limits and methods of measurement: Applies to the generation of
electromagnetic energy from sound and television receivers for the reception of broadcast and
similar transmissions and from associated equipment.

The frequency range covered extends from 9 kHz to 400 GHz.

CISPR 14-1

Limits and methods of measurement of radio disturbance characteristics of electrical motor-
operated and thermal appliances for household and similar purposes, electric tools and electric
apparatus - Part 1: Emission. This Standard applies to the conduction and the radiation of radio-
frequency disturbances from appliances whose main functions are performed by motors and
switching or regulating devices, unless the r.f. energy is intentionally generated or intended for
illumination. It includes such equipment as household electrical appliances, electric tools,
regulating controls using semiconductor devices, motor-driven electro-medical apparatus,
electric toys, automatic dispensing machines as well as cinema or slide projectors.

The frequency range covered extends from 9 kHz to 400 GHz.

CISPR 15

Limits and methods of measurement of radio disturbance characteristics of electrical lighting
and similar equipment. This Standard applies to the emission (radiated and conducted) of radio
frequency disturbances from: all lighting equipment with a primary function of generating and/or
distributing light intended for illumination purposes, and intended either for connection to the
low voltage electricity supply or for battery operation; the lighting part of multi-function
equipment where one of the primary functions of this is illumination; independent auxiliaries
exclusively for use with lighting equipment; UV and IR radiation appliances; neon advertising
signs; street/flood lighting intended for outdoor use; transport lighting (installed in buses and
trains)

The frequency range covered extends from 9 kHz to 400 GHz.

CISPR 16-1-1

Specification for radio disturbance and immunity measuring apparatus and methods Part 1-1:
Radio disturbance and immunity measuring apparatus - Measuring apparatus. This part of
CISPR 16 is designated a basic standard, which specifies the characteristics and performance of
equipment for the measurement of radio disturbance voltages, currents and fields in the
frequency range 9 kHz to 18 GHz. In addition, requirements are specified for specialized
equipment for discontinuous disturbance measurements. The requirements include the
measurement of broadband and narrowband types of radio disturbance. The requirements
include the measurement of broadband and narrowband types of radio disturbance.

CISPR 16-1-2

Specification for radio disturbance and immunity measuring apparatus and methods - Part 1-2:
Radio disturbance and immunity measuring apparatus - Ancillary equipment - Conducted
disturbances.

This part of CISPR 16 is designated a basic standard, which specifies the characteristics and
performance of equipment for the measurement of radio disturbance voltages and currents in
the frequency range 9 kHz to 1 GHz. Specifications for ancillary apparatus are included for:
artificial mains networks, current and voltage probes and coupling units for current injection on
cables.

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03

17



CISPR 19

Guidance on the Use of the Substitution Method for Measurements of Radiation from
Microwave Ovens for Frequencies Above 1 GHz

Describes a method of measurement for small microwave ovens (largest dimension less than 1
m) and a separate method of measurement for large microwave ovens (largest dimension
exceeding 1 m).

CISPR 22

Information technology equipment - Radio disturbance characteristics - Limits and methods of
measurement.

This Standard applies to information technology equipment (ITE). Procedures are given for the
measurement of the levels of spurious signals generated by the ITE and limits are specified for
the frequency range 9 kHz to 400 GHz for both class A and class B equipment. No measurements
need be performed at frequencies where no limits are specified. The intention of this publication
is to establish uniform requirements for the radio disturbance level of the equipment contained
in the scope, to fix limits of disturbance, to describe methods of measurement and to standardize
operating conditions and interpretation of results.

CISPR 25

Vehicles, boats and internal combustion engines - Radio disturbance characteristics - Limits and
methods of measurement for the protection of on-board receivers.

This Standard contains limits and procedures for the measurement of radio disturbances in the
frequency range of 150 kHz to 2500 MHz. The standard applies to any electronic/electrical
component intended for use in vehicles, trailers and devices. Refer to International
Telecommunications Union (ITU) publications for details of frequency allocations. The limits are
intended to provide protection for receivers installed in a vehicle from disturbances produced by
components/modules in the same vehicle.

CISPR/TR 28

Industrial, scientific and medical equipment (ISM) - Guidelines for emission levels within the
bands designated by the ITU.

This technical report provides the guidelines for emission levels within the bands designated by
the International Telecommunication Union (ITU) for industrial, scientific and medical (ISM)
application.

CISPR/TR 31

Database on the characteristics of radio services.

This Technical Report covers the rationale behind the actual database covering the characteristics
of radio services. The objective of the database is to register those characteristics which are
relevant for derivation and specification of limits for disturbance emissions from electric and/or
electronic equipment, systems and installations. Committees responsible for generic and/or
product emission EMC standards should use this information together with CISPR 23. This second
edition includes the replacement of CISPR 23 as reference standard for the determination of
limits by CISPR 16-4-4:2007 on "model for the calculation of limits for the protection of radio
services".

IEC 61000-6-3

Electromagnetic compatibility (EMC) - Part 6-3: Generic standards - Emission standard for
residential, commercial and light-industrial environments.

This part of IEC 61000 for EMC emission requirements applies to electrical and electronic
apparatus intended for use in residential, commercial and light-industrial environments. Emission
requirements in the frequency range 0 Hz to 400 GHz are covered. No measurement needs to be
performed at frequencies where no requirement is specified.

IEC 61000-6-4

Electromagnetic compatibility (EMC) - Part 6-4: Generic standards - Emission standard for
industrial environments.

This part of IEC 61000 for EMC emission requirements applies to electrical and electronic
apparatus intended for use in industrial environments as described below. Emission
requirements in the frequency range 0 Hz to 400 GHz are covered. No measurement needs to be
performed at frequencies where no requirement is specified. This generic EMC emission standard
is applicable if no relevant dedicated product or product-family EMC emission standard exists.
This standard applies to a apparatus intended to be connected to a power network supplied from
a high or medium voltage transformer dedicated to the supply of an installation feeding
manufacturing or similar plant, and intended to operate in or in proximity to industrial locations.

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03
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B.6 ® FFT 3110 AND FFT 3100 FRONT PANEL CONTROLS AND INDICATORS

Fig. B.4: AFJ FFT 3110 and FFT 3100 Front Panel

1 - POWER ON/OFF.

2 — USB interfaces for connecting external keyboard and mouse

3-10.1" LCD display.

4 — RF OUT: Internal signal generator output
— test signal range +50 dBuV to +90 dBuV for the frequency range from 9 kHz to 110 MHz for
FFT 3110 EMI receiver (option for the frequency range from 9 kHz to 1000 MHz);
— test signal range +50 dBuV to +90 dBuV for the frequency range from 30 MHz to 110 MHz for
FFT 3100 EMI receiver (option for the frequency range from 30 MHz to 1000 MHz).

5 —RF IN1: N-type 50Q input connector

— for FFT 3110 EMI Receiver with CISPR Band A/B/C/D, f = 9 kHz + 1000 MHz;
— for FFT 3100 EMI Receiver with CISPR Band C/D, f = 30 MHz + 1000 MHz.

6 — RF IN2 (option): N-type 50Q input connector
— for FFT 3110 EMI Receiver with CISPR Band A/B, f =9 kHz + 30 MHz;
— not available for FFT 3100 EMI receiver .

7 — STATUS INDICATORS LEDS (from left to right):

COLOUR | NAME FUNCTION
RED RF OUT The LED is lit when the internal signal generator is activated
RFIN 1 - . .
RED RF IN 2 (if available) The LED is lit during measurements in the CISPR Bands

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual — rev. 2.8 / 2023-03
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B.7 * FFT 3110 AND FFT 3100 REAR PANEL CONNECTIONS

Fig. B.5: AFJ FFT 3110 and FFT 3100 Rear Panel

1 — POWER ON/OFF - FUSE, including power-on switch and two 5x20mm, 1 A slow-blow fuses and
Socket for power cord (use Class | type only).

2 — PC board with VGA/DVI interfaces, 4 USB ports, 3 audio jacks, 1 PS2-port for mouse/keyboard,
LAN port (RJ-45 connector + Standard Category 5e cross — cable or better) for connecting the
instrument to an external PC.

3 — WARNING Labels: Maintain Ground Line to Avoid Electrical Shock & Line Voltage Selector Inside;
No User Serviceable Parts Inside; Do Not Remove Covers; Refer Servicing To Trained Personnel;
Replace Fuse Only With Fuse of Specified Type and Rating. Recycling Warning; CE marking; Made in
Italy statement.

4 — REMOTE CONTROL CONNECTOR for AFJ external devices (e.g. LS16C/10 and LT32C/10).

5 — AFJ Product Label showing equipment Model, Serial Number, rated voltage and frequency of
power supply.

6 — AUDIO / OUT external audio demodulation output with volume adjusting control and loudspeaker
(1 W RMS).

7 — EXT. REF. 10MHz IN and OUT (signal amplifier).
8 — COOLING FAN.
Note: ALWAYS leave sufficient space behind the instrument to allow enough air circulation. Do not

cover the ventilation holes. A distance of about 20 cm must be kept between the rear panel of FFT
3110 and FFT 3100 EMI receivers and any wall.
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B2

Check the outside of the carton package to assess possible shipping damage: in case of damage, possibly
remove the device from the packaging, in presence of the Carrier. Keep the packaging material available
for further inspection with the Carrier, in case the damage shows up after unpacking. In case of damage,
immediately notify Carrier and local AFJ Distributor or Sales Office, for report. Do not try to install a
damaged unit. After checking for device integrity, verify that all items listed and ticked on the PRODUCT
CHECK LIST put inside the packaging, are duly present. If not, send immediate report to your vendor. If
everything is OK, proceed in the INSTALLATION routine.

C.1 « PREVENTION AND SAFETY NOTE

SECTION C: SYSTEM INSTALLATION

The instruments are SAFETY CLASS | equipment and must be connected to an approved power supply
socket, with proper earth wiring. Never interpose an extender cable without earth wire, between the
socket and the devices. The protection fuses must be replaced exclusively with fuses of the same type,
rating and speed specifications.

Any adjustment, maintenance or repair operation on the EMI receivers, implying opening of the case,
should possibly be carried out without power: if this turns impossible, such operations should be carried
out by an authorized person, well aware of the hazards involved.

The user is sole responsible of undertaking all necessary provisions for the safe usage of the EMI receivers.
Power source check: on the rear panel, you will find a type plate. Please check whether the EMI receivers
have been prepared for the correct power line voltage of your public power. If the power supply voltage is
different please inform AFJ Instruments or your AFJ representatives.

Connecting the EMI receivers to the power line: please use the supplied power cord for connecting FFT
3110 and FFT 3100 EMI receivers to your public power supply. The power supply must have an earth
safety wire. Please check the earth connection on your power outlet before you connect and turn on your
AFJ equipment.

C.2 ¢ INSTALLATION PROCEDURE
C.2.1 ¢ SYSTEM

FFT 3110 and FFT 3100 EMI receivers incorporate a last generation PC with WINDOWS 10 Embedded OS.
Regardless of EMI Receiver model and SW version selected, a USB-stick is provided. Please contact AFJ
Instruments or your local AFJ distributor for information about software updates always available free of
charge.

The calibration data are stored directly on NVM (non-volatile memory) of the FFT 3110 and FFT 3100 EMI
receivers so they do not need to be managed by the user.

For the processing of test data coming from any of the AFJ FFT 3000 family instruments the minimal

system requirements for external remote control PC are:

— PC®- compatible system, with PENTIUM IV® or AMD® processor, 400 MHz or above

— 512 MB-RAM or higher

— 1024 x 768 pixel monitor (suggested)

— LAN port

— OS VERSIONS: Windows 8 (Home Premium, Professional and Ultimate) and Windows 10 (Pro,
Enterprise)
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C.2.2 « CONNECTION PROCEDURE

FFT 3110 EMI and FFT 3100 EMI receivers need to be connected to external keyboard and mouse to be
ready to operate through 10.1” LCD display (alternatively the connection of an external monitor output
(VGA/DVI) is also possible) for stand alone usage (preferred mode), as well a direct connection via LAN-
Ethernet to hosting PC, through a Category 5 cross-cable (Cross cable is included in the delivery) as shown
in Fig. C.1.

- e e -
UTP CATS cross cable _
ETHERNET LAN X 10/100 Mbps " g
Y .
——— |
External remote control PC AFJ FFT 3110 EMI Receiver

Fig. C.1: Connection procedure for FFT 3110 EMI receiver
C.2.2.1 « STAND ALONE USAGE

Once connected to external keyboard and mouse for stand alone usage, a working version of the
operating software is already installed on the PC integrated in the FFT 3110 and FFT 3100 EMI receivers.
The operating software consists of two parts: the server and the client software.

The server software starts automatically by itself at the start-up of the operative system (Fig. C.2):

FF13010 Server Uersion: 01.00
ExtT10_ELAD_RR3318_DLL_v»2 _@.d11. DDA 1.2 at 122.88 MHz ADC frequency. Ush data acfg
lquizition rate: 6.144 kSample for band B, 192 kSample for band A. single channelfg

fiConf iguring HW: please wait...

HW Configuration Completed®

Fig. C.2: FFT 3110 EMI receiver system start-up

If it does not start automatically, it has to be either run manually by double clicking the AFJ_FFT 3110
(AFJ_FFT 3100) red icon (Fig. C.3) or recover the automatic start condition (see next paragraph C.2.2.3).

Fig. C.3: FFT 3110 EMI receiver server software icon

When the server software has completed the hardware configuration (Fig. C.2), also the client software
starts automatically by itself.

If it does not start automatically, you have just to start it manually either by double clicking the AFJ_FFT
3110 (AFJ_FFT 3100) blue icon on the Windows desktop or as an alternative, selecting Start => Programs
=> AFJ_FFT 3110 (AFJ_FFT 3110) under the Windows graphic user interface (Fig. C.4). It is possible to
recover the automatic start condition with the creation of a basic task to run the client software at the
start-up of the operative system (see next paragraph C.2.2.4).
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ﬁ AFJ FFT3110 N

» All Programs
E—

W

RESIE I

Fig. C.4: Starting of the FFT 3110 EMI receiver client software

The following software window appears (Fig. C.5):

IP ADDRESS (127,001 ' TEST

RUN [] Show SWiog

OFFLINE
Fig. C.5: FFT 3110 EMI receiver IP address setting

The IP address of FFT 3110 and FFT 3100 EMI receivers is set by default to 127.0.0.1 and it does not need
to be modified by the end user. TEST button allows to check the status of the communication between the
equipment and the PC integrated inside with the indication of system information (Fig. C.6).

AF) FFT3110 [

oA Model: R3310

¥ HW Version: 1.2

K Serial Mumber; SEOCOT
R3310 Server Version: 01.01
ExtlO_ELAD RX3E310_DLL w2 0.dil. DDA1.2 at 122.88 MHz ADC
frequency. Ush data acquisition rate: 6.144 kSample for band B, 192 k55%

| ok

Fig. C.6: FFT 3110 EMI receiver system information

Push RUN button to access the operating software for the first time (refer to next section D). If Show SW
log checkbox is flagged, the Loading... window appears showing the sequence of system information data
loading when the equipment starts to communicate with the PC integrated inside (Fig. C.7).

Loading...

Fig. C.7: Sequence of system information data loading
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C.2.2.2 « REMOTE CONTROL USAGE

In order to install the program to an external remote control PC with Ethernet port, please follow the next
steps:

PERFORM THE FOLLOWING STEPS

STEP 1 - After connecting the EMI receiver to an appropriately grounded mains, ensure that all the
electrically powered devices connected to the equipment in the measurement set-up are connected to a
common ground. Connect the EMI receiver power cord to a grounded outlet, too.

Connect via LAN-Ethernet the device to an external remote control PC through either a UTP Category 5
cross cable or a standard Ethernet LAN 10/100 MB cable.

STEP 2 — Insert USB-stick in an USB port, from Windows Explorer, locate the “FFT 3110 Receiver (FFT 3100
Receiver)/Operating SW/AFJ_FFT 3110ClientSetup_XYZ_20XY (AFJ_FFT 3100ClientSetup XYZ_20XY)”
folder on your AFJ USB-stick and double click on “Setup” file (Fig. C.8).

[N AF) FFT3110_SETUP

Elli. 02/01/2020 09:46
s 311 MB

Fig. C.8 — Setup file for client software

STEP 3 — AFJ EMI receiver software installation.

The Installation Wizard starts automatically.

On next window, to proceed forward click “Next >” (click “Cancel” to exit installation), see Fig. C.9.

On next window, see Fig. C.10, you can accept the default parameters or as alternative “Browse...” a
different path (or write directly a different folder name) for storing the installation files.

1) AF) FFT3010 m=m 5] AFJ FFT3010 e X ]
welcome to the AFJ FFT3010 Setup Wizard E Select Installation Folder @
The inztaller will guide you through the steps required ta install AFJ FFT 3010 on your computer. The inztaller will install &FJ FFT 3070 to the following folder.

Tainstallin this folder, click "Mext". Ta install to a different folder, enter it below or click "Browse".

Folder:

C:\Program Files [«86]\AFJWAF) FFT 30704 Browse...
wWARMING: This computer program is pratected by copyright law and international treaties Install AFJ FFT3010 for yourself, or for anyone who uses this computer:
Unauthorized duplication or distribution of this program, o any portion of it, may result in severe civil
or criminal penalties, and will be prozecuted to the mazimum extent possible under the law. .
@ Everyone
0 Just me
o) e O
Fig. C.9: AFJ EMI Receiver Setup Wizard window Fig. C.10: Select Installation Folder window

Here you can also calculate the necessary disk space by clicking “Disk Cost” (about 9.1 Mb for AFJ EMI
receiver software).

You can install AF) EMI Receiver for Everyone (all User Accounts listed in the Control Panel) as suggested,
or only for the current user (not recommended).

Now the installer is ready to install AFJ EMI Receiver Software on your computer.

You can also go back to revise previous step by clicking “< Back” (or click “Cancel” to exit installation: this
is the last warning).
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Please click “Next >” to complete the installation (Fig. C.11).

Complete window appears (Fig. C.12).

Confirm Installation @ Installation Complete

The installer iz ready to install AF) FFT 3010 on pour computer,

Click "Mext" to start the installation. Click "Close’ to exit,

[ Cancel I I < Back I [ Mext > J

Fig. C.11: Confirm Installation window

Now click Close to exit the installation procedure.

Note: nevertheless the equipment is remotely controlled by an external PC, the AFJ Local Database is
always located on PC integrated in the FFT 3110 and FFT 3100 EMI receivers with WINDOWS 10 Embedded

OS at the following path (Fig. C.13):

AFJ FFT 301 0 has been successfully installed,

Cancel

C:\Program Files\Microsoft SQL Server\MSSQL10 50.SQLEXPRESS\MSSQL\DATA\

At the end, the message “AF)] EMI Receiver has been successful installed” appears, the Installation

Pleaze use Windows Update to check for any critical updates to the \MET Framewark.

< Back Close

Fig. C.12: Installation Complete window

@uv| » Computer » Win Embedded Std (C:) » Program Files » Microsoft SQL Server » MSSQLI0 _50.SQLEXPRESS » MSSQL » DATA

Organize « Include in library + Share with + Mew folder
=
* Name Date modified
Gl bt | & Db_R3300.1df 03/02/2014 15:09

|=| Documents

[F Db_R3300.mdf

s :

a M :

JI p.::lc | Zl Db_R3300HwSettings.Idf

|| Pictures ;

é Vid [ Db_R3300Hw5ettings. mdf 03/02/2014 15:14
ideos

[H master.mdf 03/02/2014 15:14

= [ & mastlog.df
-k
g ._E'COmputer [A model.mdf 03/02/2014 15:14
fm Win Embedded Std (C:) | = e
1= | & modellog.ldf 03/02/2014 15:14

Fig. C.13: AFJ Local Database location

Here you find for example for FFT 3110 EMI receiver the following two files: Db_FFT 3110.ldf and Db_FFT

3110.mdf.

Right click on each one at turn, setting their Properties => Security. Below you can find an example of the

Type

SQL Server Pataba...
SOL Server Databa...
SQL Server Databa...

S0L Server Databa..,

5QLS

SQLS

ver Databa

50L Server Databa

S5QL Server Databa.,

ver Databa..,

Size

3.840 KB
175488 KB
% 92.864 KB
8192 KB
4, ‘B
768 KB
1.280 KB
512 v

Security property you need to run the AFJ EMI Receiver Database for current user.
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STEP 4 — AFJ EMI receiver software running.

Once the server software has completed the hardware configuration of EMI receiver (see paragraph
C.2.2.1), in order to run the client software on the external remote control PC you have just to start it
either by double clicking the AFJ_FFT 3110 (AFJ_FFT 3100) blue icon on the Windows desktop or as an
alternative, selecting Start => Programs => AFJ_FFT 3110 (AFJ_FFT 3100) under the Windows graphic user
interface (Fig. C.14).

Note: the client software has not to be run in the operating system of the equipment for standalone

usage.
' AFJ FFT31L0 l}

» Al Programs

f | |_T:'_."-:r* progroms gngd files ju |
AF) FFT3110
Fig. C.14: FFT 3110 EMI receiver client software icon

STEP 5 — When the client software is running, it automatically looks for the equipment connected to the
external remote control PC (Fig. C.15).

B AF) FFT3110 - ver 1.20 Ll

Connection to AFJ FFT3030 Server

Please Wait...

| Go to remote Panel |

Fig. C.15: FFT 3110 client software running

If the connection between client software and the equipment is not possible automatically, the next step
is to insert manually the right IP address of the EMI receiver to get the communication between the
equipment and the external remote control PC.

Pushing Go to remote Panel button, Fig. C.16 appears.

AFJ FFT3110 - X

IP ADDRESS [izzo01 | TEST

RUN [C] Show 5W log

OFFLINE
Fig. C.16: FFT 3110 EMI receiver IP address setting

To drive the EMI receiver by external remote control PC it is recommended to set static IP address in the
Internet protocol (TCP/IP) Properties (from Control panel => Local Area Connection Properties) on both PC
as follows:

1. PCintegrated in the EMI receiver
IP:192.168.1.2
Mask: 255.255.255.0
Note: please disable the Firewall on this PC (Fig. C.17).
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af=

ﬂ Windows Firewall
& = ~ 4 @ > ControlPanel 5 System and Security > Windows Firewall

Control Panel Home Help protect your PC with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your PC through the
Allow an app or feature Internet or a netwaork,

through Windows Firewall

& Change notification settings Update your Firewall settings
& Turn Windows Firewall on or Windows Firewall is not using the recommended 5 Use recommended settings
off settings to protect your computer,

%) Restore defaults
Advanced settings
% g

Troubleshoot my netwerk l o Private networks Not connected

What are the recommended settings?

l @ Guest or public netwarks Connected

MNetworks in public places such as airports or coffee shops

Windows Firewall state: Off

Incoming connections: Block all connections to apps that are not on the list
of allowed apps

Active public networks: = Unidentified network

Motification state: Motify me when Windows Firewall blocks a new app
Fig. C.17: Firewall setting in the PC integrated in the EMI receiver
2. External remote control PC

IP:192.168.1.3
Mask: 255.255.255.0

After typing the IP address of the PC integrated in the EMI receiver (Fig. C.18) push RUN button to access
the operating software for the first time (refer to next section D).

IP ADDRESS 192.168.1.2 TEST
RUN [] Show SWleg
OFFLINE

Fig. C.18: FFT 3030 EMI receiver IP address setting

TEST button allows to check the status of the communication between the equipment and the external
remote control PC with the indication of system information (Fig. C.19).

AFI FFT3110 o3|

@l Mode!: R3310
o HW Version:1.2
~ Serial Number; SEOCO7
R3310 Server Version: 01,01
ExtlO_ELAD _R¥3310 DLL v2 0.dll. DDA 1.2 at 122,88 MHz ADC
frequency. Usb data acquisition rate: 6,144 kSample for band B, 192 k587

——

Fig. C.19: FFT 3110 EMI receiver system information
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B2

Push OFFLINE button to access the operating software in demo mode (Setup and Report pages only) (Fig.
C.20) to display the measurement results and to manage the database (refer to next section D).

L
File Tools 7

Setup  Report

Workspace Operating Mode
Loaded Workspace | Waorkspace Display Name |Workspace D.UT ;r}.;.w dut
Company |CompanyName Model |new model
Find Workspace Laboratory |LabName i S/N i
Single Test Settings
1 non
none
I e
Limit Diagram
Limt 1 |-none - v Freq. Units | Hz v| Display Unts dBuV ~  Xstat 30.000.00013  Xstop 35.000.000 |2
Lmit 2 |-none - = X Division ] Point Num 10 v Y start (1= Y stop 10015
Per Division
Scale |Log v B Auto Set Plot
Close
INSTRUMENTS
Workspace ‘F‘.’{’ﬂﬁ(spar:e ! Tests Saved Number | 0 Connection Iid#i:’ﬂmﬂ o =

Fig. C.20: Operating software in OFFLINE mode

If Show SW log checkbox is flagged, the Loading... window appears showing the sequence of system
information data loading when the equipment starts to communicate with the external remote control PC

(Fig. C.21).

Loading...

Fig. C.21: Sequence of system information data loading

Note: When the EMI receiver is connected via LAN cable (either cross or standard), it is normal to receive
a Limited or no connectivity warning: anyhow the communication between PC and EMI receiver is active

and running properly (Fig. C.22).

e
BRTHAO T s

Fig. C.22: Limited or no connectivity warning indication

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual —rev. 2.8 / 2023-03



C.2.2.3 ¢ RECOVER OF SERVER SOFTWARE AUTOMATIC START

To recover the automatic start condition of the server software, please follows the next steps:
STEP 1 —In the PCintegrated in the equipment, please open
Control Panel -> System and Security -> Administrative tools ->Task Scheduler

and Delete the old FFT3110Server (FFT3100Server) task (Fig. C.21).

e A6 BE

() Task Scheduler (Local)

e i taty Triggers NextRunTime LastRunTime  LastRun Result Author Created Rt ]
4 [ Task Scheduler Library ™ a
o FFTI010 Ll FFT3010Server tunning At log on of any user R < >+ s currently running. (0x31301) KIOSK\utente 9/29/2014 19:5 il NAAERLS
» 2] Microsoft T Running At system startup E:: ctask is currently running. (541301) KIOSK\utente 7/22/2014 08:5 | ] Create Basic Task
= WPD P % Create Task

isable

L Import Task...

port...

[ Display All Running Tasks

& Enable All Tasks History

| New Folder.

X Delete Folder
< W 5 View »
General | Triggers | Actions | Conditions | Settings | History (disabled) | 1G] Refresh
Name: FFT0L0Server Help
Location:  \FFT3010 Selected Irem -
Author KIoSKiutente b Run
Description = End

§ Disable

Export.

L Properties

K Delete
Security options Help

When running the task, use the following user account:
Administrators
@ Run only when user is logged on
Run whether user is logged on or not
Do not store password. The task will only have access to local resources

Run with highest privileges

Hidden Configure for. | Windows Vista™, Windouws Server™ 2008

Fig. C.21: Delete of FFT 3110 Server task

STEP 2 — Create a new task (Create Task...) either with mouse right-click or with the command in the right
panel (Fig. C.22).

T Task Scheduler =)
File Act
@«
s s
© Nome Status  Triggers Nedt Run Time _Last Run Time Last Run Result Author  Created Ackes
3 itor _ Running At system startup 1/26/2015 110722 AM_The tasks curently running. (0et1301) PC\utente 6/21/2014 3:4029 PM. (A 1) -

Trport s
[ Display AllRunning Tasks
fé] Enable All Tasks History
% New Folder,
X Delete Folder
View >
@ Refresh
B Hep
Selected tem B
b Run
= End
& Disable
Export

el Tgges | Acions | Condtions | Setings | History (dsabled)

HwMonitor
\FFT3010

@ Properties
PCutente

K Delete
Help

The task will

Run with highest privileges

Hidden Configure for: | Win

Creates a customized task for advanced users.

Fig. C.22: Creation of a new task
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STEP 3 — In Create Task window please select Tab General and edit the name of the new task
“FFT3110Server (FFT3100Server)”. On Security options section select Run whether the user is logged on or
not checkbox and confirm Run with highest privileges checkbox.

Proceed clicking on Change User or Group option (Fig. C.23).

(& Create Task Lﬁ;&

General ITriggers | Actions | Conditions | Settings|

Mame: FFT30105erver
Location: YFFT3010
Author: KIOSK\ utente

Description:

Security options

When running the task, use the fellowing user account: i
KIOSK\utente

[ Change User or Group...

@ Run only when user is logged on "

() Run whether user is legged on or not
Do not stare password, The task will only have access to local computer resources,

(@ Run with highest privileges ]

[7] Hidden Configure for: [Windcmrs Vista™, Windows Server™ 2008 'l

Fig. C.23: Tab General configuration

Proceed clicking on Advanced option (Fig. C.24).

Select User or Group L

Select this object type:
|User, Group, or Built4in security principal Ohject Types...
From this location:

<

Enter the object name to select (examples):

| Check Mames

=== ok | [ Cosl |

Fig. C.24: Advanced option selection
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Proceed clicking on Find Now and select Administrators on Search results section (Fig. C.25).

S
Select this object type:

User, Group, -c.;ur Eh:lilt-in security principal

From this location:
:

Common CQueries

M arme Starts with | Columns
[Dezenption: | Stads with
[isabled accounts . Stop

| Mon expiring password

Al e lazt log jz-’:'_-'
Search results: 2 H Canerd ‘

MName {(RON) In Folder

]
8
2, Distributed C...
82, Event Log Re... PC
25 Guest FC
E‘r_"dGuests PC
52 115_IUSRS PLC
§2,LOCAL SERV...

Fig. C.25: PC Administrators configuration

In the following window confirm with OK (Fig. C.26).

I

Select User or Group @
Select this object type:
|User, Group, or Built4in securty principal
From this location:
<
Enter the object name to select (zamples):
PChAdministrators Check Names

(Coc ) o]

Fig. C.26: PC Administrators confirmation
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STEP 4 — In Create Task window please select Tab Triggers to create a new trigger. Select At log on and

Any user. Be sure Enabled checkbox is selected (Fig. C.27).

Mew Trigger B AN -

— ——

Begin the tas [ﬁ

Settings

(71 Specific user;

Advanced settings
[7] Delay task for: 15 minutes

[7] Repeat task every: |1 hour

[] Stop task if it runs longer than: B-da;.-z
[l Activate: 2015 (14:50:23

1/26/
[ Expire: | 1/26/2016 14:50:23

[¥] Enabled

[ ok || cance
Fig. C.27: New Trigger configuration

STEP 5 — In Create Task window please select Tab Actions and click on New.... to create a new action (Fig.

C.28).

(L1 Create Task
Actions | Conditions | Settings

When you create a task, you must specify the action that will cccur when your task starts,

==

Action Details

l Mew... l Edit... Delete

Fig. C.28: New Action creation

OK ] [ Cancel
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In the following window (Fig. C.29) select from the list of the available actions Start a program. Click on
Browse... and select the file at the path

C:\Users\utente\Local\Server\AFJ_R3300_Server.exe
In Start in (optional) specify the directory
C:\Users\utente\Local\Server\

and confirm with OK.

Mew Action =
You must specify what action this task will perform.
Action: ﬂStart a program vl]
Settings

Program,/script:

ColUsershutente\LocalhServer\ AF)_R3300_Server.exe

Add arguments (optional):
Start in (optional): [ k:\Users\utente\anal\Su ]

[ OK ] Cancel

Fig. C.29: New Action configuration
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STEP 6 — In Create Task window please select Tab Conditions and disable all the options (Fig. C.30).

(L) Create Task (==

| General | Triggers | Actions| Conditions | Settings|

Specify the conditions that, along with the trigger, determine whether the task should run. The task will not
run if any condition specified here is not true.

Idle
[T] start the task only if the computer is idle for: 10 minutes
1 hour
Stop if the computer ceases to be idle
Restart if the idle state resumes
Power

[] Start the task only if the computer is on AC power
Stop if the computer switches to battery power
] Wake the computer to run this task
Network
[T] start only if the following network connection is available:

Any connection

[ ok || canca |

Fig. C.30: New Conditions configuration

STEP 7 — In Create Task window please select Tab Settings, select Allow task to be run on demand and If
running does not end when request force it to stop checkboxes.
Confirm with OK (Fig. C.31).

(L) Create Task i

| General | Triggers | Actions | Conditionsl Settings |

Specify additional settings that affect the behavior of the task.

[ Allow task to be run on demand ]

D Run task as soon as possible after a scheduled start is missed

[Tl ¥ the task fails, restart every: 1 minute

[ Stop the task if it runs longer than: 3 days

[ If the running task does not end when requested, force it to stop ]

[] 1If the task is not scheduled to run again, delete it after: 30 days
If the task is already running, then the following rule applies:
’Do not start a new instance v]
[ 0K l I Cancel

Fig. C.31: New Settings configuration
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C.2.2.4 « RECOVER OF CLIENT SOFTWARE AUTOMATIC START

To recover the automatic start condition of the client software, it is necessary to create a basic task to run
the client software at the start-up of the operative system.
Please follows the next steps:

STEP 1 —In the PC integrated in the equipment, please open
Control Panel -> System and Security -> Administrative tools -> Task Scheduler

Task Scheduler application can be also found from Windows Start menu (Fig. C.32).

Programs (1)
f.f) Task Scheduler

- See more results

task scheduled % | Logoff | » |

Fig. C.32: Windows Start menu
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STEP 2 — In Task Scheduler window please create a new task to start client software selecting FFT3110 (FFT

3100) folder in the left panel and Create Basic Task... in the right panel (Fig. C.33).

- Taikachedulsy

Ganeral |r..5,..,|.nnm. Carebnns | Sabtr | Histary (iashled)
Harra: Habdamiar

Lacation  VFFTION
Buktern PCiubents

Dascnpnon:

SacLr Ry Dptirs
weher rurring the bk, usebha Frllmaing uier aecourk
PChutenie
Pl Bl S wled B Rdrged o
S Run whithar usar v legged enor nak
Dicnat stare pas saceid. The taik vall ke have access toocal resonces

Ruir wich high et prvileg e

Hicdclen Configareton [ Vindwas ¥ie™ Windvay Seneer™ 20

Fig. C.33: Task Scheduler window

= -
Bl Bction iew - Help
% *EEE
5 T"zs':l""u"'u‘“(‘” [ mitii Trgger: Feot Fur Tire LactFusn Tiie L st R Fa it Puthor Creatd Actiom
i I g l Brtabonknr  fannieg S e ataup IT/ZNLE SAL A The bzt i corrently rurreng, (=000 PClbente G000 Sasapny | |FETAEN : 2

¥ il Running &k on ofary wier QT/THLE BT 00 The bash s criently nevang. (2ALI00  PCystente  LTRG0ES 3502 FIA ] Croaba Basie Tusko *
= Create Task..
et Tazk,s

W Digpdyy Al Auniing Tasks
G Erable i Tazhs Hiskoin
Piew Falder,
3 Dieletn Falder
Wie [
& Refresh
H Heip L
Selartd b -
bR
= End
& Dibls
Export.
n Propetiz)
K Dot
B Hep

STEP 3 —In Create Basic Task Wizard window please insert the task name and then click Next (Fig. C.34).

Create Basic Task Wizard [ =3
"f}_'fl Create a Basic Task

Create a Basic Task Use this wizard to quickly schedule a commaon task. For more advanced options or settings
Trigger such as multiple task actions or triggers, use the Create Task command in the Actions pane.
Action Marme: StartClienk

Flnsh Bescription:

[ Mext = J- Cancel

Fig. C.34: Create Basic Task Wizard window
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STEP 4 — In Create Basic Task Wizard window please choose When I log on option in the Trigger Task panel
and then click Next (Fig. C.35).

Create Basic Task Wizard

@ Task Trigger

Create 2 Basic Task When do you want the task to start?
o
Action
Finish D Yeekly
Monthly
One time

) When the computer starts
I @ WhenlIlogon

When a specific gvent is logged

« Back J| Mext = | Cancel |

Fig. C.35: Task Trigger window

STEP 5 — In Create Basic Task Wizard window please choose Start a program option in the Action panel
and then click Next (Fig. C.36).

Create Basic Task Wizard [
g Action
Create a Basic Task
Trigger What action do you want the task to perform?
Start a Program I @ Starta program I
AL Send an e-mail
Display a message
< Back ] | Neat = Cancel

Fig. C.36: Action window
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STEP 6 — In Create Basic Task Wizard window in Start a Program window please click on Browse... button

(Fig. C.37).

Create Basic Task Wizard

g Start a Program

Create a Basic Task
Trigger
Action

Starta Program

Finish

Program/script: .
I | Browwse.., ‘
Add arguments (optional):
Start in {optional):
< Back Cancel

Fig. C.37: Start a Program window

STEP 7 — Please browse in C:\Program Files (x86)\AFJ\AFJ FFT3110 (AFJ FFT3100)\ folder,
AFJ_R3310_RECEIVER.exe application and then click Open (Fig. C.38).

Open
() [ & « Program Files 636) » AF) » AFIFFT3010 v [ 43 ]| Search AR FrT3010 ol
Organize « Mew folder = O @

. MName ’ Diate Type o

W Fawvorites
B Desktop
& Downloads
= Recent Places

- Libraries
jl Documents
&' Music
| Pictures

& videos

‘M Cormputer
&, Local Disk (C)

= | AFJ_R3310_RECEIVER
{9 AFJ_R3310_RECEIVER.exe
|| AF)_R3310_RECEIVERInstallState

% ColorSlider.dil

m

% DataPlotter.dil

% DelcomDLL.dI

m icona

= InstallBanner
e % mcl_pmdil

% Microsoft.Reportiiewer.Common.dll

% MicrosoftReportViewer.DataVisusliz..,

(g elad rf lab 3001~ ¢ | I

File name: AFJ_R3310_RECENER

% CustornControl OrientedTextContro..,

ﬁ:a[_lpﬁt-‘j.'_ll,'lr'l

37242016 5:58 PM
3/24/2016 5:58 §
6/27/2014 4:2
3/24/2016 5,58 PM
32472016 5:58 PM
3/24/2016 5:58
32472016 5.5¢
3/24/2016 5:58 PM

A ASINTE E.E0 DA
3/24/2016 5:58 PM

T/2/2014 2:23 PM
372472016 5:58 PM

3/24/2016 5

¥ML Configura
INSTALLSTATE
Application ext E
Application ext
Application ext
Application ext
lcan

JPEG image
Application ext
Application ext
Lpplication ext -

L

v [Blfites %)

= |

[ Open

] | Cancel |

Fig. C.38: Browse window

select
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STEP 8 — In Create Basic Task Wizard window after the selection of the required application please click

Next (Fig. C.39).

Create Basic Task Wizard

g Start a Program

Create 3 Basic Task
Trigger
Action

Finish

Program{script:
"C:\Program Files (xBEWAFNAF) FFT3010%AF)_R3310_RECEIVER exe" Browse...

Add arguments (optional)

Start in (optional):

< Back H Next > H Cancel

Fig. C.39: Selection of the required application

STEP 9 — In Create Basic Task Wizard window please select Finish panel, verify the Name, Trigger and
Action fields, select Open the Properties dialog for this task when I click Finish option and then click Finish

(Fig. C.40).

Create Basic Task Wizard

j summary

Create a Basic Task
Trigger
Action

Start a Program

Xl
MName: StartClient
Description:
Triggen Ak startup; At system startup
Action: Start a program; "C:\Pragram Files (<86)\AFIVAR FFT3010VAF)_R3310_RECELVI

[¥] Open the Properties dialog for this task when I click Finish
When you click Finish, the new task will be created and added to your Windows schedule,

I < Back ] Einish | Cancel

Fig. C.40: Finish window
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STEP 10 — The new StartClient basic task is right now created and the StartClient Properties dialog box is
open. Please select General tab and verify that Run only when user is logged on option is selected and
then Select Run with highest privileges (Fig. C.41).

& StartClient Properties (Local Computer)

| Tnggers !Al:tians I Conditions | Settings I Histary (disabled).

MName: StartClient
Location: \FFT3010
Authar: PChutente

Description:

Security options
Wifhen running the task, use the following user account:
PChutente Change User or Group...

I @ FRun onlywhen user is logged on I

Run whether user is logged on or not

Do not stare password, The task will only have access to local computer resources,

[¥] Run with highest privileges ‘

| Hidden Configure for: lWinduws Vista™, Windows Server™ 2008 '|

[ 0K I | Cancel J

Fig. C.41: General tab

STEP 11 — Please select Triggers tab and click on Edit button to modify trigger settings (Fig. C.42).

(L) StartClient Properties (Local Computer)

| Actions | Conditions | Settings | History (disabled)|

| General |/ Trigger

When you create a task, you can specify the conditions thatwill trigger the task,
Trigger Details Status
Atlogon At log on of PChutente Enabled
Mew,., ! Edit.., ‘ l Delete ‘

' L OK J Cancel

Fig. C.42: Triggers tab
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STEP 12 — In Edit Trigger dialog box please verify that Begin the task field is set to At log on. In Settings

section please select Any user option and click OK to confirm the new settings and to come back to
StartClient Properties dialog box (Fig. C.43).

Edit Trigger E
Begin the task: IAt iog;_ I
Settings

@ Any user .

Spe;jﬁl; user

Advanced settings
[T Delay task for: 15 minutes

[] Repeat task eveny: |1 howr for i 1 day

[T] Stop task if it runs longerthan: 3 days

[T Activate: | 4/ 7/2016 10:34:26 AM
[ Expire: | 4/ 772017 10:34;
[¥] Enabled

Fig. C.43: Edit Trigger dialog box

STEP 13 — Please select Actions tab and verify the status according to Fig. C.44.

(5 StartClient Properties (Local Computer) @

| General | Triggers |J1‘.ct|0ns| Conditians: | Settings | Histary {disabled)

Whenyou create a task, you must specify the action that will occur when your task starts,

Action Dretails

Srart @ prrogram ‘CAPrograrn Files GeBRNAFMAFT FFTIN10VAFI_RIZIN_RECETYER, pxe”

ﬂew | [ edr. ]| Qelete"m

[ ek || conee

Fig. C.44: Actions tab
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STEP 14 — Please select Conditions tab, in Idle section verify that Start the task only if the computer is idle
for option is not checked and that Stop if the computer ceases to be idle is checked but the check box is
not enabled. In Power settings deselect Start the task only if computer is on AC power and verify that Stop
if the computer switches to battery power is checked but the check box is not enabled (Fig. C.45).

(%) StatClient Properties {Local Computen @

|Genera| |Triggers | .ﬁ\ctionsl Conditions |Settings I History {disabled)

Specifythe conditions that, along with the trigger, determine whether the task should run, The task will not
run if any condition specfied here is not true,

Icle
[ Start the task anly if the computer isidle for: 10 rrinutes
Thour
I Stop if the computer cezses to beidle I
Restart if the idle state resurnes
Fonrer

[ iStart the task only if the computer s on AC power
I Stop if the computer switches to pattery pouwer I
[ Wake the commputer to run this task

et
[ Start anly if the following network connection is available:

Ay connection

[ ok | [ cone

Fig. C.45: Conditions tab

STEP 15 — Please select Settings tab and verify the options according to Fig. C.46.

(1) StartClient Properties (Laocal Computer) @

51| Histary (disshled) |

| General ITriggers |Actions | Caonditinns |

Specify additional settings that affect the behavior of the task,

Aoy task to be run ondemand

[ Runtask as saan as poisible after a zcheduled startis missad

[T] Fthe task fails, restart every: 1 minute
3
Idays -

I Stop the tazk if it runs longer than:

I If the running task does notendwhen requested, force itto stop

[T Ithe task is not scheduled ta run again, delete it after: 30 day:
If the task is already running, then the following rule applies:
Do not start a new instance e
[ Ok l ’ Cancel

Fig. C.46: Settings tab
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STEP 16 — Please select History tab, verify the options according to Fig. C.47, then click OK to confirm the
changes in StartClient Properties and to come back to Task Scheduler application.

(L StatClient Properties (Local Computer

| General | Triggers | dctions | Conditions | Settings | Histery (dissbled) |

" Mumber of events: 0

Level Date a..  Ewert.. Task Category Operational Code  Correlation Id

General | Detalls

Log Mame:

|| »

——

Cancel

Fig. C.47: History tab

STEP 17 — Right now the StartClient task shall be set in Running status. In the central panel of Task
Scheduler application, the new StartClient task is added but Status is set to Ready according to Fig. C.48.

Please execute Run in the right panel to modify the status.
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Fig. C.48: Status settings
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STEP 18 — Right now the StartClient task has the proper status of Running (Fig. C.49).
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Fig. C.49: Status of Running for StartClient task
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SECTION D: OPERATING INSTRUCTIONS
D.1 e START OF THE APPLICATION

When the operating software is running, it shows the Setup box of the EMI Receiver (Fig. D.1). This screen,
with its five options Setup, Run Test, Analyze, Generator and Report, constitutes the so-called cockpit.

atl AF) FFT3110 - ver 142 - m| P
File Tools 7

Setup  Run Test Anabze Generstor Report
Operating Mode

Workspace
Loaded Workspace | Workspace v Display Name |""‘"°"ksll‘ﬁ’3e DUT. |newdut FFT SCAN &
Comparny Model |new model

Mew Workspace Find Workspace Laboratony S/N

Single Test Settings

Frrrrme e 10 = 0dB = - none - &
Stop Frequency |1mmuumn | He <]
RF Input Catle
Trace 1 Distance from Limit Setup F [
IN1 w -none - v
Peak v Limit1 ] Limit2 ™
Trace 2 Uit =i
QPeak ~ | [ Limit1 Limit2
Trace 3

C_AVG «| [ Limit1

Limit Diagram
Limit 1| EN55011-GP-G1.2Class B e Freq. Units [Hz | Display Urits [dBpv  ~| Xstat| 30000000013 xXstop| 20500000005
Limit 2 | EN55011-AV-G1,2Class B v X Division | 10 Paint Num. 4 | Yt = ¥ stop 100[=
Per Division J Al
System Automation Scale |Log = Auto Set Plot
LISN LT22C ~ LISN Line Heutral [ Auto
Close
INSTRUMENTS
Workspace |Workspace Tests Saved Number | 37| Connection | LAN | Stats |33 - -

Fig. D.1: The Setup box of the FFT 3110 EMI Receiver cockpit
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D.2 e THE SETUP BOX
The Fig. D.2 shows the Setup box of the FFT 3110 EMI Receiver.

atl AF) FFT3110 - ver 142
File Tools 7

Setup  Run Test Anabze Generstor Report

Workspace Operating Mode
Loaded Workspace |W0rkspace v Display Name |""“'°|'ksll‘ﬁ’3e DUT. |newdut FFT SCAN &
Comparny Model |new model
Mew Workspace Find Workspace Laboratory | LabMame S/N
Single Test Settings
Start Frequency | 30000000 He . Time: {ms) Attenustor Antenna / Probe
= 10 =& 0dB “ - none - v
Stop Frequency |1mmuumu | He v
RF Inpt Cable
Trace 1 Distance from Limit Setup F [
IN1 w -none - v
Peak v Limit1 [ Limit2 ™
Trace 2 -none - s
QPeak ~ | [ Limit1 Limit2
Trace 3

C_AVG ~ [ Limit1

Limit Diagram
Limit 1| EN55011-GP-G1.2Class B e Freq. Units [Hz | Display Urits [dBpv  ~| Xstat| 30000000013 xXstop| 20500000005
Limit 2| ENS5011-AV-G1,2Class B ¥ XDivison 10 Port Num. 39 0] Ystan 0] Ystop 1002
Per Division T
System Automation Scale |Log = Auto Set Plot
LISN LT32C w|  LISNLne Heutral [ Auto
Close
INSTRUMENTS
Workspace |Workspace Tests Saved Number | 37| Connedionl LAN | Statws |00 | - -

Fig. D.2: FFT 3110 EMI Receiver setup window

The upper portion of Setup window is labeled Workspace and is filled with default
change to fit your own needs.

data you can easily

Note: You cannot change directly the data written in the workspace section, as they derive from the
underlying database. You can instead create a new workspace or select one of the stored workspace data

already created, by clicking New Workspace or Find Workspace respectively.

You can create a new workspace by pressing the New Workspace button or from
Workspace. In both cases, the window Workspace Information appears and you
following data:

menu File => New
can fill it with the

Display Name, Laboratory, D.U.T. (Device Under Test), Model, S/N (Serial Number) and Company (see Fig.

D.3) in the New Workspace box.

55 New Workspace =]
Workspace Information
Display Name W
Laboratony LabMName
DUT. new dut
Model  new model

5/N

Company  CompanyName I}

Fig. D.3: Setup New Workspace Information
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By pressing Save the new workspace data will appear in your current workspace (see Fig. D.4).

Setup | Run Test | Analyze | Generator | Report |
Workspace

Loaded Workspace  [[ENRIAIE e :
New Workispace
New Workspace My Name m

Fig. D.4: Choose your Workspace

You can also manage to list, filter, load, modify and delete your saved Workspaces, by pressing the Find
Workspace button or from menu File => Find Workspace. In both cases, the Workspace Management
window appears (see Fig. D.5). This window is subdivided in the three sections: Filter (for research tasks),
Workspace list and Workspace Information. The current workspace is already highlighted (selected) and its
data are listed in the Workspace Information.

==l

E Workspace Management:

Filter

Waorkspace name D.UT.

Mode!

Clear Fifter

Company

Laboratory SN

Name: Laboratory Modsl

LabName

Compary

New Workspacs new model

CompanyName

My Name IMy Laboratory Name My EUT

My Company

Workspacs Information

Workspace name Test 1 DUT.  Generc EUT

Company

Lsboratary

‘ Load

Company Name

Labaratory Name

Save Modfications

Model  Model

SN 111111119

‘ Close ‘

{ Delete Selected

Fig. D.5: Workspace Management window

Any operation on workspaces can be performed easily, being the meaning of different fields intuitive for
the user.

The Filter is especially useful when you have many workspaces, which cannot fit in just a screen, and it
enables you to find out your saved data in a fast way.

You can filter your data according to one or more fields as Workspace Name, Company, Laboratory, DUT,
Model, S/N: the found data appear immediately in the list and the first found in the Workspace Info
section.

You can select another workspace from the list by clicking on it: you can now Load or Delete Selected
workspace with the below buttons. When a workspace is selected, all its data appears on the Workspace
Info, so enabling you to modify them. After done that, press Save Modifications to store new data, Close to
go back to main workspace screen.

Note 1: Please, be aware that any modification you make on any saved workspace, will have an impact on
all the data stored in that workspace and consequently in the whole Database you are working with. On
the other hand, it is easy to make changes on all data taken during a measurement session.

Note 2: The software is able to manage *.txt files with American indication (comma to separate
thousands; dot to separate decimals), please leave unchanged the international settings of the PC with
default configuration.
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D.2.1 ¢ OPERATING MODES

Referring again to main Setup window (Fig. D.2), focus now on its upper right portion Operating Mode.
Here you can choose one of the three operating modes: FFT Scan, Filter and Van Der Hoofden Test.
These modes can be selected from the drop-down menu Operating Mode (Fig. D.6).

Operating Mode

FFT SCAN M
FFT SCA

FILTER

VAN DER HOOFDEN TEST

Fig. D.6: Operating Mode selection among FFT SCAN, FILTER and VAN DER HOOFDEN TEST options

FFT Scan Mode

This is the default mode, being the most convenient mode for usage in most situations, allowing for fast
and still reliable measurements. It is an important opportunity for experimenting with the FFT scan for any
kind of interferences and be able to compare the results with the classic EMI receiver Sweep Modes. This
task can be done easily with FFT 3110 and FFT 3100 EMI Receivers.

FFT Scan Mode has a fixed frequency step of 46,875Hz from 9kHz up to 150kHz, 3kHz from 150kHz to
30MHz and 24kHz from 30MHz to 1000MHz and it can be operated with up three detectors at the same
time and two different Limits (1 and 2).

Refer to the left portion of Single Test Settings section for Trace 1, Trace 2 and Trace 3, each trace is
checked against one of two limits (see Fig. D.7).

In this mode, as well as the Sweep Mode, up to three different detectors can be selected at the same time.

Single Test Settings

Start Frequency | 30000000 He v
Stop Frequency 1000000000 Hz v
Trace 1 Distance from Limit Setup
Peak v M Limt1 [ Limit2
Trace 2
QPeak «| [ Limit 1 Limit 2
Trace 3

CAVG ~| Oumit1 M
Fig. D.7: Setup of the Single Test Settings section for FFT Scan Mode with three traces at once

The limits must be selected in the Limit section (in the left-lower part of Setup box, see Fig. D.8).

Limit
Limit 1 | EN55011-QP-G1,2Class B ~
Limit 2 | EN55011-AV-G1,2Class B v

Fig. D.8: Selection of limits in the Limit section

Filter Mode

This optional feature is especially suited to perform CISPR 15 Insertion Loss Measurements.
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FFT 3110 EMI receiver is automatically set according to the requirements of IEC 62493 Ed. 2.0:2015-03
standard (Assessment of lighting equipment related to human exposure to electromagnetic fields) (Fig. D.9)
for measurements with Van Der Hoofden Test Head model AFJ VDH 30.

Van Der Hoofden Test

Frequency range Bélasc;;r:iézg_:o Measurement time Tstep Detector
20 kHz — 150 kHz 200 Hz 100 ms 220 Hz Peak
150 kHz — 10 MHz 9 kHz 20 ms 10 kHz Peak

Fig. D.9: IEC 62493 Ed. 2.0:2015-03 standard requirements for measurement equipment
On the Setup box the Single Test Settings will be automatically grayed out (Fig. D.10).

53 AF FFTA030 - ver 130Beta [E=H B X

File  Tools 7

un Test | Analyze t Generatar ! Fiepart |

‘Workspace Operating Mode
Loaded \Warkspace Workspace - Display Mame  Warkspace DOLLT.  news dut
Compary  CompanyM ame Model  new model EET SCAM =
Mew wWorkspace | | Find ‘Waorkspace Laboratory  LabMame S/

Single Test Settings

Meas Time [mz]  RF Input Attenuators Antenna /FProbe
GkHz 10MHz Peal 0 = RF M1 v| lPreamp v| |— nane - v|
Cable
|- none - v|

Amplifier/Attenuator

|' none - x |

Limit Diiagram

Lirnit 1 | DigcLiml = | Freq. Urnitz | Hz - ‘ Display Lnits |dB|,L\," - | * stait 150,000 = sgtop|  100.000,000

Lirnit 2 | Limit Ramp - i Pairt Murn. e =

| | # Division | 10 Per Division 10 v| ' stait 300 ¥ stop 1004
System Automation Scale [Log v| [] Auta Set Plot
|-n0ne- v| (E 12 | Neutral
‘ Close ‘

INSTRUMENTS
‘“Workspace ‘wWorkspace Operating Mode  FFT SCaM Tests Saved Mumnber s Corinection L&k Status

Fig. D.10: Setup box settings for Van Der Hoofden Test operating mode

D.2.2 ¢ SYSTEM AUTOMATION

You can also add the System Automation (Fig. D.11).

|LISN L516C =] LISN LIME ILine1 v] Auto

Fig. D.11: Setup System Automation section for an AFJ LISN choice

” Syztem Automation
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For FFT 3110 EMI Receiver you can add either AFJ LISN LS16C/10 or AFJ LISN LT32C/10.

Then you can choose the LISN LINE to measure. Possible choices are:

- Line 1 or neutral for LISN LS16C/10 (single phase LISN);

- Line 1, Line 2, Line 3 or Neutral for LISN LT32C/10 (three phase LISN).

The phase is switched after you press the Start button in the Run Test box (the led on LISN front panel will
switch on).

If Auto option is selected, the measurement will be performed in sequence automatically on all the phases
of the selected AFJ LISN.

You can also choose the SyA Script function for the System Automation. In this case the LISN LINE gray out
(Fig. D.12).

" Swystem Automation

Im ﬂ SN Line | Neutral

Fig. D.12: Setup System Automation section for LISN choices

This function requires a text script files to be programmed; this file allows you to make an automatic
sequence of measurements. In this file you change test name, operator name, test conditions and
specifications, test notes and you can send commands to RS232 serial port via the host PC.

As soon START is pushed into 'Run Test', the SyA Script Log window appears and it is required to load the
* txt file that contains all the commands.

Commands syntax is the following:
OPEN232 COM1,9600,N,8,1  Open COM1 port with baud rate=9600, parity=None, data bits=8, stop

bit=1.
Wait 2000 Wait for 2000 ms
WR TN Test Namel Write 'Test Namel' into Test Name field (TN = test name)
WR OP Operator Namel Write 'Operator Namel' into Operator field (OP = operator)
WR CO Test Conditions1 Write 'Test Conditions1' into Conditions field (CO =condition)
WR SP Test Specificationsl Write 'Test Specifications1' into Specifications field (SP= specification)
WR NO Test notel Write 'Test notel' into Test Note field (More Info button)
WRITE232 COM1 *idn? Send the string '*idn?' plus the blank space ' ' to COM1 port
SWEEP Run the test with Frequency Table settings
// Comments on single text line

Serial port settings syntax commands:
OPEN232 baud_rate, parity, data_bits, stop_bits
Baud rate port settings: 2400, 4800, 9600, ..., 115200

Parity: None > N/ Even > E/Mark > M /0Odd - O/ Space > S
Data bits: Set either 8 or 7.
Stop bits: To set nothing insert N, otherwise 1,1.5 or 2.

LISN and Max hold settings syntax commands:

LISN O select line N

LISN1 select line L1

LISN 2 select line L2 (for LT32C only)

LISN 3 select line L3 (for LT32C only)

HOLD SET 2 enable MAX Hold and set the repetition number to 2 (defined by user)
HOLD RST disable Max hold

50
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The below script allows you to make 2 sweeps for both LISN lines, at the end saving Max hold of 4 scans.
The final result is saved as “Test Lisn 1 - L1”.

D.2.3 ¢« AN EXAMPLE OF SYA SCRIPT FILE

WR OP Operatorl

WR NO SyA Script: Scriptl.txt
WR SP Max Hold 2 Rep.

WR CO LISN LINE O

LISN 0O // Set LISN on N-line

WR TN Test Lisn 1 - LO

HOLD RST // Max Hold Reset, delete previous traces
HOLD SET 2 // Enable Max Hold with two repetitions
SWEEP // Sweep with two Max hold repetitions
LISN 1 // Set LISN on Ll-line

WR CO LISN LINE 1
WR TN Test Lisn 1 - L1
SWEEP // Sweep with two Max hold repetitions

The below script allows you to make two sweeps for each LISN line saving the max hold of two repetitions
on line LO in a file (“Test Lisn 2 - L0”) and the Max hold of two repetitions of line L1 in another
file “Test Lisn 2 - L1”.

The main difference is the HOLD RST command of the third row from the end.

WR OP Operator Name
WR NO SyA Script: Script2.txt
WR SP Max Hold 2 Rep.
WR CO LISN LINE O

LISN O

WR TN Test Lisn 2 - LO
HOLD RST

HOLD SET 2

SWEEP

LISN 1

WR CO LISN LINE 2

WR TN Test Lisn 2 - L1
HOLD RST

HOLD SET 2

SWEEP

Another example runs two different tests with their names, operators, conditions, specifications.
Between two tests the software runs a command to serial port, for example for settings an external
hardware.

OPEN232 COM1,9600,n,8,1
WAIT 2000

WR TN Test Namel

WR OP Operator Namel
WR CO Conditionsl

WR SP Specificationsl
WR NO Test notel
WRITE232 coml *idn?
WAIT 2000

SWEEP

WR TN Test Name2

WR OP Operator Name2
WR CO Conditions2

WR SP Specifications2
WR NO Test note2
WRITE232 COM1 *idn?
WAIT 2000

SWEEP

Of course mode tests can be added to the file.
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D.2.4 ¢ LIMIT EDITOR (TOOLS MENU)

The client software comes already with many measurements limits according to emission standards
CISPR/EN 55011, 14, 15, 19, 22 (both Average and Quasi Peak, Group 1/2, Class A/B where applicable). In
case of need, you can create your own limit.
This task is easily done with the Limit Editor that you find on the menu Tools => Limit => Limit Editor (see
Fig. D.13).

ol AFJ FFT3110 - ver 1.50

File | Tools | ?
Setup Limit » | LimitEditor
Work Input Device Calibration - Limit Import
Van Der Hoofden Test Limit Export
Customize » ['_' Company
5 »
S [ Laboratory
ManageAdmin Password
Singl Database 3

Fig. D.13: Limit Editor selection

In this box you can change the parameters of the current test Limit and its display configuration, with the
possibility to Add New Limit, select another Limit (Selected Limit) and Delete Limit. It is possible to add a
discontinuous limit according to the requirements for example of CISPR 25 standard with the definition of
some frequency points with No Limit definition. A frequency point added with active NoLim flag allows to
get a discontinuous gap from that frequency point up to the next one added with no active NoLim flag.
The overall functionality (Fig. D.14) is similar to the Input Device Calibration Editor (See § D.2.6), so it does
not need further explanation.

At the end of editing, you can press the Save button to store your data and then the Close button to exit.

s Limit Editor *
File

Add New Limit Selected Limit EN55014-1-QP-Cond v Delete Limit

Limit Info Chart Points
- X start
Limit Name ~[EN55014-1-QP Cond | = Frequency (Hz) Level (dByv) MoLim
9.000[%
Description  [x53 4110 1,000,000,000}% 500.000 56 ]
) ; X-Pxis Scale 5.000.000 % a
5,000,000 60 O
30,000,000 &0 O
Y start
20f
Y stop
Var Lin with Log Freq 100
B Freq 9,000/2] Level 50[ [ No Limit
Remave Add

Load from File
Close Save

Fig. D.14: Limit Editor parameters for an example of discontinuous limit
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You can also Import / Export limits in XML format (version 1.0, Standalone) for using them in different

XML-parsing programs (Fig. D.15).

! AFJFFT3110 - ver 1.50

File [ Tools | 2
Setwp | Limit » Limit Editor
Wod Input Device Calibration » Limit Import |
Van Der Hoofden Test Limit Export
Customize » Conpiary
Options » ooy
ManageAdmin Password
Singl Database »

Fig. D.15: Limit Import / Export options

With these two options (Import / Export) for Limit lines, different limits can be exchanged between two
different databases (local or remote ones, no matter), allowing maximum flexibility for any EMI Receiver

installation (Fig. D.16).

Iﬁ

L[}

Address
C:\Usershwtente' Deskiop\ R 3030mg EC_60533xml [ xMLFie | [ Sewer |
Fitter
Limit Name Description
Limit Name Description Label m‘:r? s t’:; I;peqwith

IECE0533-Table_2 |ECH0533-Table_Zor bridge and deck zone IEC60533-Table_2 <DocumertBlem... | dByY

The XML-schema for a limit is:

<?xml version="1.0" standalone="yes"?>

<NewDataSet>
<Table> ... </Table>

For the newly created limit IEC 60533 we have the following syntax:

Fig. D.16: Limit Import

<Nome> Name of the Standard (IEC60533-Table_2) </Nome>
<Descrizione> Description (IEC60533-Table_2 for bridge and deck zone) </Descrizione>
<Etichetta> Label (e.g. IEC60533-Table_2) </Etichetta>
<Punti> Points <DocumentElement> </Punti> e.g.

<Point>1</Point><Frequency>00000000389C7C41</Frequency>><Level>0000000000004B40</Level>

<Unit_Misura> dBuV </Unit_Misura>
<VarlLinearlLog> true/false (true = Lin / false = Log) </VarlLinearLog>

<Detector> QP / Pk / C_RMS etc. </Detector>

In the Import Limit an XML file can be loaded and filtered according to Limit Name and its Description.
After highlighting a Limit, press Import to import it onto your database (Fig. D.17).

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual —rev. 2.8 / 2023-03



e Import: Limit x|

Addiess

[C\Program Fles\&FLimis sl ol fle Server
Filer
LimitMame JEN Desciption |

[
Name Desciplion | Labed Foint e e Detector [
ENS5022-0P-Class & ENSS022-0P... | ENSS022-0... | <DocumentElem... | dBuy true P
ENSE022:4-Class B ENSS022:4Y._ | ENGS022:4Y- _ | <DocumentElen... | dBgy e a0
ENSE022:4Y-Class & ENSS022:4Y... | ENSS022:4Y- . | <DocumentElem... | dBiy true s
EN15-0Poop-2m EN150Foo.. | ENI5.0Foo... | <DocumentElen... | dBgy e P
EN1E-0P-Cond EN1E0PCo . |ENTSOP-Co | <Documentlem. | dBy s P =
EN154-Cand ENTG4V-Co.. |ENISAY-Co.. | <DacumentElen... | dBiy e a0
ENSE01 P61 2Clses B | ENSS0T1-0P_ | ENSSOT1-0P | <DocumentElem | di s P
ENSS011-QP-G2ClassA | ENSS011-GR.. | ENSS0TT-OF.. | <DocumentElem... | dByy true P
ENSEON PG1Class | ENSS0T1-0P_ | ENSSOT1-0P_ | <DocumentElem | B/ e P
ENSS0114Y-G12-Class B | ENSS011-AY.. | ENSS011-AY-.. | <DocumentElem... | dByv true v _

Import | Close

Fig. D.17: Limit Import of an XML-file

D.2.5 ¢ SINGLE TEST SETTINGS

In the Single Test Settings section of the Setup window you can change the Start / Stop Frequency of your
scan selecting the Frequency Unit, Measurement Time, RF Input connector (RF IN1, RF IN2 (if available)
and CAL (internal loop with direct connection between RF Input and internal signal generator output)),
Attenuator Level (Manual attenuator mode only, please notice that AUTO attenuator mode is not
foreseen; Preamplifier) and Antenna / Probes, Cables and Amplifiers / Attenuator of the actual emission
chain (Fig. D.18).

Single Test Settings
Start Frequency |9|)DD | o Time (ms) Attenuator Antenna / Probe
10 = 0dB w -none - w
Stop Frequency |E’.DDDDDDD | -
Cable
Trace 1 Distance from Limit Setup
-none - ~
Peak ~ Aol / At
Trace 2 none - o
Trace 3

Fig. D.18: Single Test Settings section

Measurement Time can be set manually by the operator from 1ms to 5000ms when selecting a single trace
with Peak detector only. When another detector is selected (Quasi Peak, CISPR Average, RMS, CISPR RMS
or a combination of them), Measurement Time will be set automatically to 1000ms independently from
the selection of Peak detector and the operator will get a Warning message (Fig. D19).

Warning e

' Measurement Time will be changed at 1000 ms

s

o |

Fig. D.19: Measurement Time set automatically to 1000ms

It is possible to select for each trace which limit (Limit 1, Limit 2 or both) to consider during Peak Search
function and so to display into the table of the results the Distance from Limit of each trace (Fig. D.50).
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In the Diagram section of the Setup window you can set the parameters for graphical data presentation of
final spectrum (in the next window Run Test):

Frequency Unit: Hz, kHz, MHz, GHz

Display Unit: dBUV, dBm, dBuV/m, dBUA/m, dBA/m, dBlA, dBpW

X-axis (Frequency) Start / Stop limits (Note: these limits are only valid for the output spectrum)
Y-axis Start / Stop (Note: as above)

Point per division: 1, 2, 5. 10, 20 points per division

X division: 2, 5, 10, 20 divisions of X-axis

Note: this option is available only with the Linear scale for X-axis choice as obvious.

Scale: Linear or Logarithmic scales for X-axis: with the usual Log scale the X Division will grey out, while for
Linear scale the X Division can be set 2—-5— 10 -20 (Fig. D.20);

Diagram Diagram
Freg.Units (MHz v | Display Units |dBuV = | Xstart 30000 Xstop 3.000.000[% Freq. Units |MHz = | Display Unts |dBuV =
s N Poirt Num Py - g Point Num.
X Division | 10 Per Division 10 v  Ystat 0% Ystop 13015 X Division m Per Division 10 -
Scale |Log - V| Auto Set Plot | Enable Subrange Line Scale |Linear

D.20: Diagram window. Left: Log scale for X-axis. Right: Linear scale for X-axis.

Autoset Plot: with this option enabled, the graphic will show all measured points, according to X- and Y-
axis limits set by the user. When this option is disabled, if the range of the X-axis (Frequency) does not
match the frequency range set for the measurement a Message Box (Fig. D.21) will appear to indicate the
wrong setting.

Warning ¥

@ Plot Range error!

D.21: Plot Range error Message Box

Enable Subrange Line: with this option enabled, a red vertical (dotted) separation line at the crossings of
the subranges appears in the graphic during run-time.

If you now click on the Run Test label you see the effect on your diagram.

D.2.6 ¢ INPUT DEVICE CALIBRATION EDITOR (TOOLS MENU)

Before running your test, typically it is necessary to setup your Antenna or Probe, measurement Cable(s),
and optionally also an Attenuator/Amplifier.
This task is easily done with the Input Device Editor that you find on the menu:

Tools => Input Device Calibration => Input Device Calibration Editor (Fig. D.22)

o' AFJ FFT3110 - ver 150

File | Tools | 2

Setup ‘ Limnit »
Wom:[ Input Device Calibration  » | Input Device Calibration Editor

Fig. D.22: Input Device Editor choice
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The window of Fig. D.23 now appears.

First of all you have to press the Add New Device button (on left-top of the window): so doing, a New
Device will appear in the Selected Device drop-down menu and you can edit all its properties.

In the middle section Input Device Info you can choose a different Name and Type of your device in use
among Antenna/Probe, Cable or Amplifier/ Attenuator.

You can adapt the range for X-axis, namely frequency in Hz (by default, this is the full range 9 kHz up to 1
GHz) and the range for Y-axis, namely Level in dB (by default, this is +20 dB). For this task, you can use the
up/down arrow (in this case the graphic will be updated automatically), or directly editing the values with
the keyboard and then pressing Enter to redraw the graphic.

On the Points section you can enter the couple Frequency / Level [dB] and press Add. The data points are
ordered as you enter them, but you can Reorder or Remove point.

22 Input Device Calibration Editor =1 ]
File

Selected Device New device - | Delete ‘

Device Name  New device Frequency (Hz) Value {dB)

X start Y start
0004 H

X stop Y stop
1.000.000.000 | 2

[

Fed 9000 Hz Value 000} dB [ Add ]

| Close: | |  Remove | | Reorder | | Load From File |

Fig. D.23: Edit Input Device Calibration window

You can press the Save button to store your data, the following message appears (Fig. 24):

Message

Fig. D.24: Device calibration updated confirmation

In the next page, we have set the typical parameters for the device calibration of an external attenuator
20 dB Attenuator (Fig. D.25) and one for a log-periodical antenna (Fig. D.26).

In the first case, all data were entered manually, by adding them directly in the Input Device Calibration
Editor.

In the second case, the data were imported with the function “Load From File”. For this action, you need
to write down a simple Text file with two tab delimited fields - use Export Text (tab delimited) from Excel,
Notepad or a similar editor - with the couple values of frequency expressed in Hz and the antenna factor.
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An example of a such file is here:

270000000 15.51
275000000 15.22
280000000 15.24
285000000 14.98
290000000 14.87 etc.

@Iﬂput Device Calibration Editor = = @
File

‘ Add New Device ‘ Selected Device New device - ‘ Delete ‘

Device Name  Fuise imiter 20 dB Frequency (Hz) Value (dB)
30.000.000 20,00
e i 100.000.000 20,05
Probe/Antenna 500.000.000 2010
Cable
Chatt 1.000.000.000 20,15
Htart 7 statt
30.000.000[% 2012
3.000.000.000 2030
X stop ¥ stop .
2,000.000.00013 202
o]
Freg | 300000000015 Hz Ve 2030+ dB [ Add |
‘ Close ‘ | Remove | [ Reoer | | Load From Fie |

D.25: Input Device Calibration parameters for an external 20 dB Attenuator

E Input Device Calibration Editor _n:_|_| = @
File

Input Device Info Paints

Device Name  Log-periodical Antenna

Type Probe/Artenna -
Chart
X start Y start
270.000.001 0
X stop Y stop
1.000.000.000 1 e
305.000.000 14,52
’7 310.000.000 1442
—
Freq S000[2{ Hz Value 0.001%|dB [ Add |
| Close | | Remove | [ Reomer | | Load From File |

D.26: Input Device Calibration parameters for a log-periodical antenna
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The Load from File button allows you to import data from a file. The file must contain all the couples
Frequency / Value (dB), separated by a blank space.

It is possible to protect with User / Password the access to the Input Device Calibration Editor .
See § D.2.10 for further information.

D.2.7 ¢ TOOLS MENU

The other commands found in the Tools menu are as shown in Fig. D.27:

o AFJFFT3110 - ver 1.50

File | Tools | 7

[Cetup Limit »

woﬂ. Input Device Calibration »
Van Der Hoofden Test
Customize »
Options »

ManageAdmin Password
Sinal Database »

D.27: Commands of the Tools menu

Van Der Hoofden Test for calculating F factor from peak detector measurement sweep into the
frequency range f=20kHz+10MHz when using FFT 3110 EMI Receiver with Van Der Hoofden Test Head
model AFJ VDH 30 according to IEC 62493 Ed. 2.0:2015-03 standard (Assessment of lighting equipment
related to human exposure to electromagnetic fields) (Fig. D.28).

= Van Der Hoofden Test |

Test Data |[ZE0W0

Fram s

[] Generate Dutput Fils
GO
Generate Report

Fig. D.28: Van Der Hoofden Test Software Tool

With Test Data you select where to find (either from local database or from file) the measurement result
obtained with VDH 30.

With Load Test the measurement result is selected and loaded.

Pushing GO you get the F factor with either “PASS” (F<1) or “FAIL” (F>1) indication (Fig. D.29), with the
possibility to generate at the same time an output *.txt file (Generate Output File) with the following
information:

frequency (Hz); test level (dBuV); current density Jcap(f) (A/m?); electric field Ecap(f) (V/m)
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With Generate Report you automatically create the report with all the information about measurement

with VDH 30.

Van Der Hoofden Test ]

Test Dats  From file -

| Load Test ChUzers"AFJ\Desktop'WDH30 b

[¥] Generate Output File
GO

‘ Generate Report ‘

Fig. D.29: Van Der Hoofden Test Result

D.2.8 ¢ CUSTOMIZE (TOOLS MENU)

From this menu, you can change the palette color appearance of the software windows/report and the
information showed in the report.

Customizing your Colors

Tools => Customize => Colors

Here you can change colors for Software Display and Print/ Report (Fig. D.30).

The colors for the lines and the Max Hold lines with different detectors (Peak, QPeak, C_AVG,

RMS/C_RMS) as well as for limits 1 & 2 and the Reference line can be changed at will.

The Plotters colors refers to background, axis and grids of the spectrum in the Run/Analyze mode. For

instance, you can set the background to white (255, 255, 255 RGB) instead of default black.

|2 Color Theme Editor

|| Austomabic Lenit Curve Colo Setting

[T sk for Automatic Limk Curve Color Setting

SLEL RGP
Flottes Colors Fant an

Backgound [ 0. 0.0 [=]
doie [ 128128128 =)
Gid 128128128 [&]

OFeak Une [ ] 255: 256:0
C_AVG Lne [l 255; 0; 255

AMS Line [T 0; 255: 255
C_AMS Lie |[] 255: 215.0

AMS Lre Ref [ ] 132

C_RMS Line Ref |[] 265;224;192

Limit 1 Line (] 192:192:0
Limit 2 Leve ([ 255 0 255
Marker 1 Color | [ 255:0:0
Marker 2 Color || 0:128: 0
Analyze Markess Lnes | 255; 69: 0

Pesk Line |[] 192; 255, 192

Peale Line Ref |[] 192: 266192
Pesk Line Ref | 255; 255,192

C_AVG Line Ref ] 265; 192; 255

Detault Polstie Edi [ whie =] [0 | Remove
Laad | Save [] white v 50 | ddd
| gawe | Close

D.30: Color Theme Editor
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The first time you open this window, the option “Ask for Automatic Limit Curve Color Setting” is checked.
If you leave it such way, then the following window will appear (Fig. D.31):

Automatic Limit Color Settings \EI
QP/AVG limit color and QP/AVG curve color are different.

Do you want to automtically set QP /AVG limit color at the same color
of the QP/AVG curve?

@ Yes ~) No

Fig. D.31: Automatic Limit Color Settings for QP/AVG limits

If you answer “Yes” then the other flag for “Automatic Limit Curve Color Setting” will be checked.
If you answer “No” and “Don’t ask anymore” then the flag for “Ask for Automatic Limit Curve Color
Setting” will be unchecked.

Customizing your Reports

Tools => Customize => Report

In this window (Fig. D.32), you can edit some Report options, namely Report Title & Comments (three
lines possible). You can set also the “Show Date and Time” & “Show Subrange Settings” options.
m Repaort Options &J

Report Title
AFJ FFT3010 Report

Comments

Report Comment 1
Report Comment 2
Report Comment 3

Show Date and Time
Show Subrange Settings

Fig. D.32: Report Options

D.2.9 ¢ OPTIONS (TOOLS MENU)
Tools => Options => Peak Search Setting

Peak Search Settings lists the parameters for Peak Search (appropriate for evident peaked spectra) and
Max Search (for smoothed spectra, with no evident peaks). A limit must be set to get results of both
searches. Threshold (dBuV), Peak Escl (dB), Max Peaks Number, Threshold From Limit (dB) and Show All
Detected Peaks (Fig. D.33).

Peak Search Settings X Peak Search Settings x
Mode [Peak Search |  Mode
Max Search
1015 |Peak Search _|
Threshold 103 Threshold Pegk Search
Peak Escl (dB) 303 Peak Escl (dB) 0=
Max Peaks Number 2037 Max Peaks Number 2015
Threshold From Limt (@8) | 100154 Threshold From Limt @8) | 1005
[[] Show Al Detected Peaks ] Show All Detected Peaks
OK Cancel OK Cancel

Fig. D.33: Peak Search Settings
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Note: The Peak Search will be effective only if a Limit is selected and associated to the detector of the
Trace 1 in the Single Test Settings part of the Setup cockpit (Fig. D.34):

Trace 1
Feak »| [#] Limitd
Trace 2

Trace 3

-

Fig. D.34: Limit selection on Single Test Settings section

Threshold (dBuV): this parameter allows to set a minimum limit to the max/peak search routine, i.e. no
peaks are considered below this level. The default value is -10dBlV, which is below the noise limit. So, in
practice, that means that all peaks are considered. This line settles the threshold under what the peaks
must be cut out from the inquiry, it is a factor which distinguish a peak from the nears.

Peak Escl (dB): this parameter allows to search only the peaks having a difference of more than [Peak Escl]
from the local minima just aside the peak. The default value of this parameter is 6dB.

Maximum Peak Number: is the number of peaks to retain for each scan: this field allows setting an upper
limit to the number of peaks to be considered in the table (max. 200 peaks).

Threshold From Limit (dB): this parameter allows to set the distance from the limit for considering the
max/peak search routine, i.e. peaks with a distance from the limit bigger than this value are not
considered. The default value is 10dB.

Show All Detected Peaks (dB): all the values of the detectors used during the measurement associated to
the detected peaks by the max/peak search routine will be shown.

Note: “Threshold”, “Peak Escl” and “Threshold From Limit” parameters distinguish various kinds of peaks
and their maximum values, to help the choice of the most significant disturbances. Due to difficulty of
automatic max peak selection, it is always possible to approach and complete the inquiry in manual mode.

Tools => Options => Plot Screenshot Settings

The Plot Screenshot Settings window lists Width/Height pixel size for the output bitmap of the working
spectrum. Default Plot Screenshot Size is 710 x 425 pixel but it is recommended to set it at least double
(1420 x 850 pixel).

Tools => Options => Language

Selection between English (default) and Chinese.
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It is possible to protect with User / Password the access to the Input Device Calibration Editor selecting:

D.2.10 ¢ MANAGE ADMIN PASSWORD (TOOLS MENU)

Tools => Manage Admin Password (Fig. D.35)

o' AFJFFT3110 - ver 1.50

File | Tools | 2
Setup Limit »
Wad Input Device Calibration >
Van Der Hoofden Test
Customize »
Options »
[ ManageAdmin Password |

Fig. D.35: Manage Admin Password selection

User / Password are set by default to Admin / Admin and without any updating the User Name / Password
Message Box will not appear when accessing the Input Device Calibration Editor.

For updating the Password it is necessary to input the old Password and the new Password with the
consequent confirmation (Fig. D.36).

@E AE) FET305x Receiver et
Liser Admin
Pasmaor [T
Cancsl Ok

Mew Pasaword sees

Corfirn Hew Password ssss

| ok |
Fig. D.36: Password updating

After pushing OK the Message Box with Updated Admin Password confirmation will appear (Fig. D.37).
oK .S

Updated Admin password!

Loox |
Fig. D.37: Updated Admin Password confirmation

After updating the Password when accessing the Input Device Calibration Editor the User / Password
Message Box will appear (Fig. D.38).

[l AF! FFT30m: Recerver i
Uzer Agmin
Paeswond LT
Cancel, | oK |

Fig. D.38: User / Password Message Box
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When the database size exceeds 50% of the available space, a warning message appears at the bottom of
the Setup box (Fig. D.39):

D.2.11 ¢ DATABASE (TOOLS MENU)

Operating Mode \FFT SCAN | Tests Saved Number 25| Waming: Database Used Space > 50%! | OFFLINE

Fig. D.39: Warning message when database size exceeds 50% of the available space

In case the database size exceeds 80% of the available space, further the warning message at the bottom
of the Setup box (Fig. D.40) another warning message in a separated window appears with the
recommendation to delete some old or unnecessary test data to reduce the database size (Fig. D.41).

Operating Mode [FFTSCAN |  Tests Saved Number 0| Waming: Database Used Space > 80%! | OFFLINE |

Fig. D.40: Warning message when database size exceeds 80% of the available sy;ace

Warning b 4

Database Used Space limit over 80%! Please delete some old or
unnecessary test data.

Fig. D.41: Warning window when database size exceeds 80% of the available space

It is possible to manage the database selecting:

Tools => Database (Fig. D.42)

o' AFJFFT3110 - ver 1.50

File | Tools | ?

{ Setup Limit "
Woﬂ Input Device Calibration >
Van Der Hoofden Test E _
Customize b b v| Ds‘i?ﬂ:::
Options b [ borstny
ManageAdmin Password
Singl Database > | Backip
Restore

Delete tests

Fig. D.42: Database selection
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Tools => Database => Backup

To copy the actual database in the backup folder created automatically by the software:

C:\Users\...\Documents\AFJ\DB\BACKUP

After completing successfully the backup of the actual data base (*.bak file) a confirmation message will
appear (Fig. D.43).

Backup DBfile :
ChUsers\Marco\Documents\AFADB\BACKUP\Db_FFT3030-2020-01-31-12-
39-24,bak

Fig. D.43: Database backup confirmation

Tools => Database => Restore
To restore a previous copy of the database loading a *.bak file from the list (Fig. D.44).

Database restore X
LN « Windows (C:) » Wtenti » Marco » Documenti » AF) » DB » BACKUP v 0 Cerca in BACKUP p

Organizza ~ Nuova cartella =~ @ o

&= Immagini 4 * Nome Ultima modifica Tipo Dimensione

@ OneDrive |_| Db_FFT3030-2019-12-11-09-19-02.bak 15/01/20
| | Db_FFT3030-2020-01-15-10-54-02.bak 15/01/20

File BAK 13.232 KB
10:54 File BAK

18:04 File BAK 14.076 KB

i
- = o=

FrTanan 300 04 a0 a0 o8 nes 30/01/2

B Questo PC [ ob ane
I Desktop || Dk E]:li::e-nz:fnzik] 49 MB 1/01/20:
= Documenti Ultima modifica - 15/01/2020 10:54
+ Download
&=| Immagini
J‘! Musica
) Oggetti 3D
i Video
- Windows (C:)

File BAK 14.076 KB

ik na. i

Nome file: | | |SQL SERVER database backup fi v

Fig. D.44: Selection of the database file to restore

After completing successfully the restore of a copy of the database (*.bak file) a confirmation message will

appear (Fig. D.45).
E—!_ B

DB restore done successefully.

|

Fig. D.45: Database restore confirmation
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Tools => Database => Delete Tests

To delete from the actual database all the tests before of a date selected by the operator (Fig. D.46).

By AFIFFT311 ver 1.5
File Tools 7
Setup  Report
= 4
BY Receivel = O W
ame |Workspace ] DUT. [rewdat
Delete all tests before the selected date [Ccmpan)-Narne | Model [new e

4

ottobre 2021 b ry |LabName | SN

lun mar mer gio ven sab dom
21 28 29 30 1 2 3

4 5 6 7 8 9 10
1T 12 13 1 15 W W
18 19 20 21 2 23 24 10 =
25 26 27 28 29 30 3 :

o re T e 3

[ Oggi: 0371172021 Canicel

| Information

o Delete Tests before date 20/10/2021 00:00:00 7

.

Fig. D.46: Delete tests before a date defined by the operator

After completing successfully the deletion of all the tests a confirmation message will appear (Fig. D.47).

. —

Delete done!

OK

Fig. D.47: Deletion confirmation
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D.3 ¢ RUN TEST BOX
In the Run Test box (second label of the cockpit), you can make a measurement and analyze it in a quick

but still effective way.
To begin the run procedure, select the Start button in the Frequency section (by default, it shows the last

performed measurement), the box depicted in Fig. D.48 will appears.

Setup RunTest Analyze Generator Report

Setup -
Frequency [] Auto Save Test Det /Aten. |PK 0dB

Antenna / Probe none -

' 35.000.000 s o LTI i ——
|

Ampl / At |- none - Clear Ref. Curve
RF Input [IN1
Test Info Run Mode
Test Name |Test Number 15 v| Operting Mode [FFTSCAN | More Info M Hold
Date [27/05/202111.36 3| Condtions  |b band | [ Continuous Sweep
Operstor |1 | Specification | | [ Enable Pause

Fig. D.48: Frequency section of Run Test Box

The scan/sweep will now proceed according to all the parameters (frequency ranges, detectors, limits,
traces, etc.) you have chosen in the previous paragraphs (Fig. D.49).

Setup FRunTest Analyze Generator Report

Setup -
Frequency [] Auto Save Test Det /Aten. |PK 0dB

Antenna / Probe none - Peak Searct

| 5.000.000 e see T i e o
|

Quick Analyze

Ampl / At |- none - Clear Ref. Curve
RF Input [IN1
Test Info Rurt Mode
Test Name iTast Number 15 v | Operating Mode @I More info Max Hold
Date [27/05/202111.36 3| Condtions |b band | [ Continuous Sweep
Operator |1 | Specification | | [ Enable Pause

Fig. D.49: Frequency section of Run Test Box during measuring

Selecting Pause button the measurement will be interrupted manually by the operator and such button
will become red indicating such condition (Fig. D.50).

Setup RunTest Analyze Generator Report
Setup Quick Analyze

[] Auto Save Test  pet /aten.  |PK 0B

Antenna / Probe none - Peak Search

10,002,000 (reee|e | I ——
|

Ampl 7 Att |- none - Clear Ref. Curve
RF Input {IN1
Testinfo Run Mode
Test Name | Test Number 15 | Operating Mode [FFT SCAN More info Max Hold
Date |27/05/202111.36 @ | Contions  |b band ! [ Cortinuous Sweep
Operator |1 | Specification | | [ Enable Pause

Fig. D.50: Frequency section of Run Test Box during pausing condition

Selecting again Pause button the measurement will continue, meanwhile with Stop button the
measurement will be interrupted definitively by the operator.
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If Auto Save Test is not flagged (default choice), then at the end of each measurement, the following
window appears (Fig. D.51):

Receiver

| Test completed, do you want to save?

Yes Mo

Fig. D.51: Test terminated saving confirmation

If Auto Save Test check is flagged, automatically saving of test results without user confirmation is enable.

At the end of the measurement you can save the test with its name and perform a quick analysis directly
from this window (for a detailed analysis, please, refer to next § D.4).

In our example, the conducted emission measurement on the EUT is performed from 150 kHz to 30 MHz
in the FFT Scan mode with Peak, Quasi Peak, CISPR Average, Bandwidth 9 kHz, with 1 s measuring time.
The result of the actual measurement is shown in Fig. D. 52, as seen from the Run Test box.

5 a4 s - vero1 N .

File Tools ?

[Setup | Fun Test [ Analyze | Generstor | Repart

Setup Quick Analyzs
Frequency Det /Atten PK DdB [ PeskSeach |
30.000.000 | == | - -
e 2 Al A [ CearRef. Cuve |
Ampl./Asten
Test Info
Test Name Test Number 454 Operating Mods FFT SCAN More Info |
Date D4/02/2014 01.00 [ Condtions  FIR bw 95% di 2 MHz
Operstor S Specfication dfferent second stage CIC on FPGA + ISOP e=6

Screenshot | | EworData | Automatic detector count: Time(HH:MM:S5)  Femain Bapsed

Workspace Workspace1 Operating Mode  FFT SCAN Tests Saved Number 453 Connection  LAN Status

Fig. D.52: A frequency spectrum of conducted emission measurement from 150 kHz to 30 MHz

D.3.1 ¢ RUN TEST SECTIONS

The Setup section shows:

- Detectors in use, namely PK (green), QP (yellow), C_AVG (violet) and the value of the internal
Attenuator or the use of the internal preamplifier (Preamp);

- the presence / absence of any Probe/Antennas in use during the measurement;

- the presence / absence of any Cable in use during the measurement;

- the use of an external pulse limiter (for example AFJ PAT20M attenuator & pulse limiter) as
Amplifier/Attenuator;

- RF Input connector in use during the measurement (either RF IN1 or, if available, RF IN2).
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The Quick Analyze section is the most important section where the measurements can be checked (Fig.
D.53).

Fig. D.53: Quick Analyze section

The Peak Search function will show the following table sorted by Distance from Limit (Fig. D.54).

o5 Peak Search - Run Test >
Sort By Distance from Limit w Add with click Del Row Enable Al Disable Al Clear Table
R Antenna / Probe Cable Ampl / At Detect Meter Read Meas. Level Limit 1 Limit Limit2 Limit 2 Enabl ~
=a Factor [dE] Factor [dE] Factor [dE] SCOr [dByv] [dByV] [dByV] Dist[dE] [dByV] Dist[dE] ol

30 | 32.236MHz 2673 Peak 238 2435 30.00 -5.65
31 | 33.772MHz 2528 Peak -1.01 2427 30.00 -5.73
32 | 33.100MHz 2592 Peak -1.74 2418 30.00 -5.82
33 | 32.764MHz 2623 Peak -2.06 2417 30.00 -5.83
34 | 33.220MHz 25.80 Peak -1.96 2384 30.00 £.16
35 | 32.524MHz 26.46 Peak 275 237 30.00 £.29
36 | 32.452MHz 26.53 Peak -2.86 2367 30.00 £33

7 | 33.292MHz 2574 Peak 22 2353 30.00 £.47
38 | 34.708MHz 2448 Peak 097 2351 30.00 £.49
39 | 32.692MHz 26.30 Peak -2.30 2350 30.00 £.50
40 | 33.028MHz 2598 Peak -2.51 2347 30.00 £.53
41| 34 612MHz 24.56 Peak -1.14 2342 30.00 £.58
42 | 34.180MHz 2492 Peak -1.86 23.06 30.00 £.94
43 | 33.460MHz 2558 Peak 257 23m 30.00 £.99
44 | 574 468MHz 231 Peak 6.30 30.01 37.00 £.99
45 | 33.964MHz 2510 Peak 215 2295 30.00 -7.05
46 | 33.516MHz 2515 Peak 22 2254 30.00 -7.06

7| 34.324MHz 24.80 Peak -1.87 2293 30.00 i
48 | 34.228MHz 2488 Peak -2.00 2288 30.00 712
45 | 33.652MHz 2540 Peak 263 277 30.00 723
50 | 35.316MHz 2398 Peak 1.2 2276 30.00 -1.24 -
< >

Export Frequencies Report Close

Fig. D.54: Peak Search table of the actual spectrum, ordered by Distance From Limit

Note: A sort by either Frequency or Amplitude (in ascendant order, from the lowest value) is also possible
from the Sort By drop-down menu.

It is possible to add manually more peaks to include on the measurement report.
For manually modifying the results of the Peak Search function:

- Selecting “Add with click” and with mouse right-click on the graphic it is possible to add a row to the
table;

- “Del Row” deletes the selected row;

- “Enable All” enables the visualization on the graphic of all the peaks included into the table;

- “Disable All” disables the visualization on the graphic of all the peaks included into the table;
“Clear Table” deletes all the rows of the table.

Export Frequencies function allows to generate a Text file with the list of the frequencies of all critical
points found by the Peak Search function. An example of a such file is here:
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//ID, (Hz), (dBuVv), (dBuv), (dBpv)
0;89972000; ; ;
1;92164000; ; ;
2;98652000; ; ;
3,;368628000; ; ;
4;737284000; ; ;
5;921588000; ; ;

Report function allows to generate a report including measurement sweep and peak search table.

If a Limit is not selected and associated to the detector of the Trace 1 in the Single Test Settings part of the

Setup cockpit, selecting the Peak Search function the following warning message will appear (Fig. D.55):
Warning >

| . Peak Search: Limit not enabled on Setup.

Fig. D.55: Peak Search function warning message

You have also the choices or by clicking directly on the table headers labeled as Meter Read [dBlV],
namely the reading at main EMI receiver RF-input, Measured Level [dBUV], namely the overall chain
reading (including the effect due to any cables, antennas, amplifier/attenuators), Limits [dBUV] and Limit
Distance [dBUV] (namely the difference between the measured level and the limit at one frequency),
clicking once for descendant order and twice for ascendant order:

Meter Read |, | Meas. Level Limits Lirnit Drist. Meter Read | | Meas. Level Lirnits Lirriit Doist.
[dBpv] [dBpY] [dBpY] [dE] [dBp] 1 [3Bpv] [dBp] [dB]
I b I I or a3
Meter Read teas. Lewel | Limits Lirviit Digt. Meter Read Meas. Level | Limits Lirit Chigt.
[3Bpv] [dBpt] s | [dBuv] [4B] [dBpY] [@Buv] [ | [dBuv] [dB]
i or
Meter Read Meas. Level Liritz | Limit Dist. Meter Read Meas. Level Limitz | Limit Dist.
[3Bpv] [3Bpv] [dBu] [ | [dB] [dByY] [dBpY] [dBp] [~ | [dB]
or T

Meter Read Meas Lewvsl Ltz Limit Dist. teter Fead Meas. Level Limits Limit Dist.
[dBpt] [dBpt] [dE ] [dE] Ir\ or [dBp] [dBp] [dBp] [4B] [~

Fig. D.56: Ordering Peak Search table by Meter Read., Meas. Level, Limits, Limit Distance.

It is possible to make a manual Zoom in any spectrum window in two steps: 1) holding down the Shift-key
(™) and then left-clicking and moving the mouse in a rectangle while holding the mouse button (Fig.
D.57 A); 2) after you release it a blue rectangle appears and the area is zoomed (Fig. D.57 B):

A B
Fig. D.57: Manual Zoom on Emission Spectrum

If you want to come back to the initial view (without Zoom), you can press the Reset Zoom button in the
Quick Analyze section (Fig. D.53).
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The Clear Ref. Curve button in the Quick Analyze section (Fig. D.53) allows to clear the spectrum loaded
pressing Load Reference button in Run Test window and select a test from the list (Fig. D.60).

You can use the Max Hold function by clicking Max Hold button in the Run Mode section of the Run Test
box and set if you want to perform a Continuous Sweep as well. Pressing Max Hold button the function will
be activated and the button will switch its name to Reset in red color (Fig. D.58).

Run Mode Fun Mode

Max H'LE | | Fesst |

] Continuous Sweep
Enable Pause

@r\C_nntinuous Sweep
FI
AL Enable Pause B

Fig. D.58: Setup Max Hold section. A: Max Hold inactive; B: Max Hold active, with Continuous Sweep ON

Selecting Continuous Sweep function the measurement sweep will be repeated until the operator stops
the test manually; selecting “Enable Pause” function at the end of each measurement sweep the test
system will be in “Pause” status showing a Message Box to give the possibility to decide when to continue
with the next measurement sweep (Fig. D.59).

0- Pause, Enter to Continue

Lo |

Fig. D.59: Pause Message Box

At this point, all traces and limits in the Single Test Settings are frozen to their current states and any
change to them is not possible while Max Hold is active.

Click Reset to make Max Hold inactive and go back to single scan measurements. The red script Max Hold
Active reminds you the Max Hold active state.

By pressing Screenshot button, it enables the saving of the measurement diagrams on a *.JPG, *.PNG, or
*. BMP file. A Save as type dialog opens with Browse for directory and filename. In order not to less any
detail of your image, but still save disk space, the PNG-format for your plot is suggested (Fig D.60 and
D.61).

I Screenshot J I Export Data I I Load Reference I

Workspace RP 20170454 Operating Mode FFT SCAN

Fig. D.60: Screenshot, Export Data and Load Reference buttons

File name: ITBSLSDecIrum j Save I
Save as ype: IJF‘G [*ipal j Cancel |

IFG [ 7
BMP [~ bmp]
Alfles 7]

Fig. D.61: Saving in JPG/PNG/BMP files

By pressing Export Data button, it enables the saving of the measurement data on a text file *.txt that can
be opened by Windows Notepad or similar Editor program, or can be imported in any spreadsheet
application, being each field separated by semicolon (Fig. D.62).
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E', Test_Spectrum.txt - Notepad |

File Edit Format View Help

1,000,000,000;65.1; 56, 0; 46,
1,005,000,000;68,5; 56,0546,
1,010,000,.000;68,7; 56.0;46.
1,015,000,000;86.6; 56,0546,

o]
0
o]
0

| A~ | B | ¢ | D0 |

1 |1,000,000.000 @ 59.01.00 55.00.00 46.00.00
1,005,000.000  B5.05.00 56.00.00 450000
1,010,000.000 | B3.07.00 560000 450000
4 |1,015000.000 | 86.06.00) 56.00.000 45.00.00

Fig. D.62: Text file saved with Export Data and imported in a spreadsheet (Excel)

In the Test Info section of the Run Test box (Fig. D.63) you can write your personalized Test Name (default
is Test Number with a progressive number), the Date of test (default is the current system date), the name
of the Operator, the Conditions (usually the ambient test conditions) and Specification (Standards, limits,

etc.).
Test Info
Test Name ITest Mumber 10 Operating Mode ISW’EEF‘ g
Date |2D£1 /2001122 j Conditions |Temperature 24°C, Pressure 107 kPa, HR: 55 %
Operatar IM. Mozzi Specification IEN BE022 / CISPR 22 0P /&Y limits

Fig. D.63: Test Info section of Run Test box

You can introduce a list of possible different Test Name loading into the following directory:

C:\Program Files (x86)\AFJ\AFJ FFT3110 (AFJ FFT 3100)

a text file called TestName.txt according to the example shown in Fig. D.64.

_| TestName - Blocco note di Windows

File

IF3

AFJ
AFJ

Modifica Formato Visualizza 7
Test 34
Test 44
Test YY

Fig. D.64: Example of TestName.txt file

After restarting the client software the Test Info section will show a list of possible
per Fig. D.65.

different Test Name as

Test Info
Test Mame [ Operating Mode |FFT SCAN Mare Into
Date | AF) Test 44 Condiions |
|AFJ TestyY g
Dperator Ay T Specification |

Fig. D.65: Test Info section of Run Test box

Now you can click to More Info button and the Test Info window opens (Fig. D.66).

2! Test Info x|
Image 1 I Shaw Image 2 ™ Shaw Image 3 ¥ Show
= 2 5
a O CEEET
L vl

Lioad I

TestMote
Test Motes.

™ Auto Save Test

o |

Cancel I

Fig. D.66: Test Info window with three loaded images
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Here you can load up to three image sketches (in JPEG, PNG or Bitmap-format). They will appear in each of
the three separate windows and one of them can be shown (check Show) in your main Run Test window
(Fig. D.67), and you can add your Test Note about the current performed test.

— Duick Analyze —
Peak Search

Reset Zoom

Clear Ref. Curve E /(_/(

Mare |nfo |

Fig. D.67: Showing your Test Info image on Run Test window

You can easily work with one or two markers, by left- and/or right-clicking in any part of the displayed
spectrum window. Once activated, the first marker (red color) is driven by mouse left-click: you can put or
drag-and-drop in any point of the spectrum to read its frequency and level. A mouse right-click will add
the second marker (light-blue color) that behaves similarly at all, so enabling to make a second
measurement. The two markers on the spectrum appear as apparent in Fig. D.68.

Fig. D.68: Markers MK1 (red) and MK2 (light blue) in a spectrum

The relative measurements of the enabled detectors values will be put in the upper right portion of the
spectrum as depicted in Fig. D.69.

MEZ 1_205, 000MHZ

Fig. D.69: Marker 1 an 2 readings in the displayed spectrum

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual —rev. 2.8 / 2023-03



B2

When Van Der Hoofden Test operating mode is selected, at the end of the measurement the software will
automatically show the F factor with either “PASS” (F<1) or “FAIL” (F>1) indication (Fig. D.70).

[orl z - [
Jrd] AFJ:F[EU].U vErlLUQ“

File Tools 7

Setup | Run Test Analyzs Gangmmrf Report

Setup Quick Anafyze
Frequency Diet./Atten. PK DdB | Peak Search |
1 0 0 0 0 0 0 0 | Start | Antenna / Probe - none - |7 Reset Zoom 7!
2 . = (bl = - | ClearRef. Curve |
Ampl / At ~rone - = —
Test Info
Test Name  Test Number 40 Opersting Mode  WAN DER HOOFDI More Info ‘
Date 30/01/201502.36 B~ Conditions
Operator ABB EMC LAB Specification

V.d.H. Test F =0,068617 : PASS

Screenshct | | Bxport Data Hapsed Time 0:00:02.4 Automatic detector count: 0

Fig. D.70: Van Der Hoofden Test result

After saving the measurement data, it will be possible to load it and calculate again the F factor with the
possibility to generate a test report using the software tool described at the paragraph D.2.7.

If during a scan / sweep the SERVER COMMUNICATION FATAL ERROR message appears in the Run Test
window (Fig. D.71), FTDI (Future Technology Devices International) component for internal USB
communication of the equipment is not running properly and so please contact service center.

SERVER COMMUNICATION FATAL ERROR!

Quick Analyze
PK 0dB |  Peak Search
e - |  Resst Zoom
e | Clear Ref. Curve
- rone -

Fig. D.71: SERVER COMMUNICATION FATAL ERROR message in Run Test window
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D.4 e« ANALYZE BOX

The Analyze box is useful for making an accurate analysis of your noise spectrum. It includes a single-
frequency real-time measurement with up to three different detectors at the same time. The initial

appearance of the Analyze Box is apparent from Fig. D.72.

55 AFJFFT3110 - ver 165 X
File Tools TestTools
Setup  RunTest Analyze Generstor Report
Manual Settings
Start Frequency (30000000 Hz w Peak []QPeak []C_AVG [] Peak Averaging L=
i }1:‘ i vt v Automalic atteruator count: 0 [0dB Alt]
op Frequency | 1600060000 Hz 5 “ RF Genenatnrfﬁi % e
lessure On Table
Atenuators  Input Offset  Meas Time{ms)  Atenna / Probe Cable Ampl / At RFInput  Fiter 30MHz-1GHz
0dB  ~| Auto  ~ | 1000 5| -none- | [none - | -none- vlleal  v|[mo <] Start
D Freq PK
4| 53,652,000 21.01]
3 92,164,000 27.79
1/ 105,000,000 5206 |
2| 368,652,000 39.29
| 5737284000 2562 |
[ Add with click | ADD ROW | | DEL ROW Clear
SAVETOFILE | LOADAFILE Update all Table
[ Show Single Slice (Row select) [ Set Analyzed Freq
Test Info =
Test [Test Number 7 | cond | | spec. | | b Peak
Operater [1 | Dae [15/09/2022 0250 Nate | 85 0000005MHz

Wiorkspace | Workspace | Tests Saved Mumber | 3|

Conection [ UN_| Saws ||
Fig. D.72: The Analyze Test Box

In the Analyze box you can Load Test, make a Peak Search, Export Data, Generate Report, make a

Screenshot, Print and Reset Zoom (Fig. D.73).

. Tr:stchI:-._ ?
Load Test

File  Tools
| Setup | Run Tejsé

Manual Seftings Peak Search

J| Peak Export Data 3
Attenuators Generate Report
o -
|E} dB i Screenshot

Print

Fig. D.73: Test Tools menu of Analyze box
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Load Test. This button has much utility and different options. It opens the Test Management window
where you can load any of performed tests (Fig. D.74).

Exactly as seen for the Find Workspace window, here you can use Filter for filtering your tests by Test
Name / Operator, select one run test and change its stored data with Edit Info (press Save Modification for
storing permanently your changes), you can Load a Test and it will automatically use as a reference
spectrum for data analysis (it will superimpose to your actual real time running test), Delete Selected Tests
(you can select more than one Test by clicking on each Test while holding down the Ctr/ button) and Close.

@ e venesere N

Fiter

Test Name Operator

Clear Fitter

TestName  Date Operstor Cperi Max Hold Spectication Fondiof

 Test Humber 19| 9/4/2014 8:47 AN | Franco [Frrscan [ |cancs 40
Test Number 20| 9/4/2014 948 AN | Franco FFT SCAN = | caco &t
| M42285020 21 | 8/4/2014 953 AM | Franco FFT SCAN B\ M42285(
: Test Number 22 9/4/2014 953 AM. | Franen ] = -
| Test Number 23 | 9/4/2014 954 AM | Franca FFT SCAN ] | mazzeer
Test Number 24 | /472014 8:55 AM | Franco FFT SCAN ] | Mazaser
Test Number 25 | 9/4/2012 10:01 .. | Franco FFT SCAN o\ PSVEIC
| Test Humber 26 9/4/2014 1001 .. | Franco FFT SCAN ] |Psvsac
| Tost Humber 27 8/4/2014 10.02 .. | Franco FFT SCAN Il PSV53C
L Test Himber 78| 9//2018 1007 "‘E.;r;:; FET SCAN G .:.P.q-\./-r:l;"r =
0. |
Test o
Test Name  Test Number 22 Date [04/03/2014 0851 Opsrating Mode  FFT SCAN
Opertor  Franco Condiions  M£2283020 | Specfication

Test Note

Automation  none- Setting

Rdfications

l Delete Selected

.

.74: Test Management table for Load Test

Pressing Show-Settings button for the selected test, a window with all information on run test opens (Fig.
D.75).

Test Settings L]
Trace 1 Detector Trace 2 Detector Trace 3 Detector
0 -1 -
Fstart Fstop Fstep Bandwidth {:‘:f RF Input Attenuator Antenna / Pobe  Cable Ampl / At

150.000 30.000.000 kHz SkHz

Fig. D.75: Test Settings for a Load Test

With reference to the example shown at Fig. D.70, the loaded Test is automatically use as a reference
spectrum for data analysis reporting the waveforms with faded colors and the indication of the three
detectors with (R), so PK(R), QP(R) and CAVG(R).

Pushing the Start button, the real time measurement will be performed reporting the waveforms with
standard colors and the indication of the three detectors will be as usual PK, QP and CAVG. The actual real
time running measurement will be compared with the reference spectrum. The waveforms of the
reference spectrum of the loaded Test can be enable / disable using the checkbox on right-lower part of
the Analyze box, see Fig. D.72.
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Peak Search. This will open the Peak Search — Analyze window (Fig. D.76)

o5 Peak Search - Run Test >
Sort By Distance from Limit Add with click Del Row Enable Al Disable Al Clear Table
Freq ;;rrtenna / Probe Cable Ampl / At Detector Meter Read Meas. Level Limit 1 Li!'n'rt Limit2 Li!'n'rt 2 Enabl ~
actor [dE] Factor [dE] Factor [dB] [dBuV] [dBuV] [dBuV] Dist[dB] [dBuV] Dist[dB]

30 | 32.236MHz 2673 Peak 238 2435 30.00 -5.65

31 | 33.772MHz 2528 Peak -1.01 2427 30.00 -5.73

32 | 33.100MHz 2592 Peak -1.74 2418 30.00 -5.82

33 | 32.764MHz 2623 Peak -2.06 2417 30.00 -5.83

34 | 33.220MHz 25.80 Peak -1.96 2384 30.00 £.16

35 | 32.524MHz 26.46 Peak 275 237 30.00 £.29

36 | 32.452MHz 26.53 Peak -2.86 2367 30.00 £33

7 | 33.292MHz 2574 Peak 22 2353 30.00 £.47

38 | 34.708MHz 2448 Peak 097 2351 30.00 £.49

39 | 32.692MHz 26.30 Peak -2.30 2350 30.00 £.50

40 | 33.028MHz 2598 Peak -2.51 2347 30.00 £.53

41| 34 612MHz 24.56 Peak -1.14 2342 30.00 £.58

42 | 34.180MHz 2492 Peak -1.86 23.06 30.00 £.94

43 | 33.460MHz 2558 Peak 257 23m 30.00 £.99

44 | 574 468MHz 231 Peak 6.30 30.01 37.00 £.99

45 | 33.964MHz 2510 Peak 215 2295 30.00 -7.05

46 | 33.516MHz 2515 Peak 22 2254 30.00 -7.06

7| 34.324MHz 24.80 Peak -1.87 2293 30.00 i

48 | 34.228MHz 2488 Peak -2.00 2288 30.00 712

45 | 33.652MHz 2540 Peak 263 277 30.00 723

50 | 35.316MHz 2398 Peak -1.22 2276 30.00 724 =

£ >
Report Close

Remarks:

Antenna / Probe Factor [dB]

Fig. D.76: Peak Search - Analyze data, sorted by Distance from Limit

is the antenna / probe factor expressed in dB

Cable factor [dB] is the cable factor expressed in dB

Ampl / Att Factor [dB] is the attenuator factor for cable or amplifier/attenuator at the selected frequency
in dB

Detector is the type detector in use: Peak, Qpeak, C_AVG, RMS, C_RMS

Meter Read [dBuV] is the meter reading (V) expressed in dBuV

Meas. Level [dBuV]
Limitl [dBuV]
Limit1 Dist [dB]

Limit2 [dBuV]
Limit2 Dist [dB]

is the measured level (expressed in dBuV

is the value of the chosen limit 1 at the selected frequency

is the margin from limit 1 at the selected frequency: a negative value is below the
limit (compliant), a positive value is over the limit (not compliant)

is the value of the chosen limit 2 at the selected frequency

is the margin from limit 2 at the selected frequency: a negative value is below the
limit (compliant), a positive value is over the limit (not compliant)

Export Data. It enables the saving of the measurement data on a text file *.txt that can be opened by
Windows Notepad or similar Editor program, or can be imported in any spreadsheet application, being

each field separated by semicolon (Fig. D.77).

L | A | B | ¢ D
File Edit Format ‘iew Help 1,000,000.000 69.01.00 56.00.00 46.00.00
%, ggg, 888- 8885 23'%5 gg 8532- 1,005 000.000 E3.05.00 550000 450000
, ' . [ 1,010,000.000 E3.07.00 550000 450000

1,010,000,.000;68,7; 56.0;46.
1,015,000.000;86.6;56.0;46. 1,015,000.000 86.06.00) 56.00.00 46.00.00

(=l alelel

Fig. D.77: Text file saved with Export Data and imported in a spreadsheet (Excel)
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Generate Report. It enables to easily create a report of the loaded test. After a few instants a window
opens with your customized test report (See § E.2 for more details and information).

Screenshot. It enables the saving of the measurement diagrams on a *.JPG, *.PNG, or *. BMP file. A Save
as type dialog opens with Browse for directory and filename. In order not to less any detail of your image,
but still save disk space, the PNG-format for your plot is suggested.

Print. This prints the display in a “XPS” document with the colors chosen in the Customize Colors => Print
and Report section of the Color Theme Editor. Before printing, it opens the system Page Setup Print
dialogue box, default page orientation is landscape, with 10 mm distance from all margins.

Reset Zoom. This restore the display to its original form, by resetting any previous zoom (it works only if a
Zoom was active). It is possible to make a manual Zoom in any spectrum window in two steps: 1) holding
down the Shift-key (1) and then left-clicking and moving the mouse in a rectangle while holding the
mouse button (Fig. D.78 A); 2) after you release it, a blue rectangle appears and the area is zoomed (Fig.
D.78 B):

Fig. D.78: Manual Zoom on Emission Spectrum

If you want to come back to the initial view (without Zoom), you must choose Test Tools => Reset Zoom in
the Analyze box.
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Checking the right side of the Analyze box, it is possible to add manually more points on the frequencies
list selecting “Add with click” and using the mouse right-click on the graphic (Fig. D.79).

Pushing the Start button, the real time measurement will be performed at all the frequencies of the list
only with up to three different detectors at the same time.

Pushing “Add Row” button, it is possible to add manually other new points on the frequencies list during
the real time measurement (Fig. D.80).

I

[ Add wih cick | ADD ROW | | DEL ROW Ciear

SAVETOFILE || LOADAFILE | [ Update ol Table
[ Show Single Siice {Row ssiect [ Set Aralyzed Freq

Fig. D.79: Manual addition of points on the frequencies list

Add Frequency
|

| mHz || kHz || Hz |

Fig. D.80: Manual addition of points on the frequencies list

“Delete Row” button allows to remove a selected frequency from the list and the “Clear” button allows to
delete all the frequencies of the list.

“Save To File” button allows to save into a file the list of all the frequencies of the table with all the last
real time measurement performed. Such file can be loaded again selecting “Load A File” button.

“Load A File” button allows to load a Text file generated by “Export Frequencies” function including the list
of the frequencies of all critical points found by the “Peak Search” function.

To update the real time measurement of all the frequencies of the table it is necessary to select “Update
all Table” checkbox.

When “Select Slice using Row Table” checkbox is selected, it is possible to continue the measurement in
the frequency range of the slice that includes the selected point into the frequencies list (Fig. D.81).

AFJ FFT 3110 AND FFT 3100 EMI RECEIVERS — Operating Manual —rev. 2.8 / 2023-03

78



Lemit 1: EN550

D Freq PK
1 51.996.000 1073
2 101.996.000 60,94
3 151.996.000 61,06
4 201996000 60,95
5 251996000 61,15
7 351.996.000 1354
8 401996000 12,79
9 451996000 1343
10 501.996.000 1226

Fig. D.81: Select Slice using Row Table

[ Add wihcick | ADDROW | DEL ROW Oear
SAVE TO FILE LOAD A FILE [[] Update-al Tabie
[] Select Shics using Row Table [[] Set Ansizye Freg

When “Set Analyze Freq” checkbox is selected, it is possible to set the Start / Stop frequency of the
measurement according to the frequency range of the slice that includes the selected point into the

frequencies list (Fig. D.82).

Limit 1- EN55011

D Freq PK
1 51886000 10,73
2 101.996.000 60,94
3 151.996.000 61,06
4 201996000 60,95
5 251996000 61,15
7 351.996.000 13,54
8 401.996.000 12,79
9 451.996.000 1343
10 501.996.000 1226

Fig. D.82: Set Analyze Freq

[ Addwihcick | ADDROW | DELAOW |  Oear
SAVE TO FILE LOAD AFILE |_| Update al Tadle
[] Select Stioa using Fow Table [ Set Arisizym Freq
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The lowest part of the Analyze box window is the so-called Test Info (Fig. D.83), including the information
saved in the Test Management window. These comprise Test Name (default one is Test Number with a
progressive number), name of the Operator, Date of test (default is the current system date), Conditions
(the ambient test conditions), Specification (Standards, limits, etc.) and Note.

Test Info
Test 1 MHzcomb generstor Cond. 20°C, 100kPa, 60% RH Spec. CISPR 22 Standard

Operator M. Mozzi Date |20/02/2014 11.34 Note |This was a test with a Field Ref Source in the freq. range 1-3 GHz

Workspace New Workspace Operating Mode  FFT SCAN Tests Saved Number 12 Connection LAN Status

Fig. D.83: Test Info section of Run Test box

Also into the Analyze window you can easily work with one or two markers with the same procedure
described into the Run Test box (section D.3.1, Fig. D.68 and D.69).

D.4.1 ¢ THE MANUAL SETTINGS SECTION

In the Manual Settings section you can choose the Start / Stop Frequency of your scan selecting the
Frequency Unit and up to three from five available detectors, by flagging their names. There is a sketch of
the Analyze section with one detectors (Peak) at Fig. D.84.

Manual Settings
Start Frequency 30000000 | Hz v Peak [] QPeak [] C_AVG [] Peak Averaging 4 &
eeaee— = Automatic attenuator count: 0 [OdB Alt]
Stop Frequency 400000000 | Hz « [1RMS []C_RMS [ Max Hold ﬁ ~»
EA Measure On Table
Atenuators  Input Offset  Meas Timeims)  Antenna / Probe Cable Ampl / At RFinput  Fiter 30MHz-1GHz
0dB ~ | Auto v 0 [ | -none- ~ | -none - ~ | -none - ~ || INT v | 120kHz Stop

Fig. D.84: Manual Settings of detectors, attenuators, etc.

The Attenuators (0 / 10/ 20 / 30 dB or PREAMP), the Input Offset (Auto/Disabled) and the Meas. Time (ms)
can also be set by the end user.

It is possible to include correction factors coming from external devices included into the measurement
setup (Antenna/Probe, Cable, Amplifier/Attenuator).

RF Input connector in use (either RF IN1 or, if available, RF IN2) during the measurement.

Filter 30MHz+1GHz allows to select which CISPR EMI Filter Bandwidth use (either 9kHz or 120kHz) during
the measurement in Band C/D from 30MHz to 1GHz (Fig. D.85):

l_:jﬁ‘e_r: 30MHz-1GHz

Fig. D.85: CISPR EMI Filter Bandwidth selection

It is possible to display on the diagram the average of the last N measurements with Peak detector only by
flagging Peak Averaging option and introducing the number of measurements (in the example shown on
Fig. D.84, N=4).

You can use the Max Hold function by flagging Max Hold option.

The Automatic attenuator count indication shows how many times the internal attenuators has been set
automatically by the system during measurement.
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By flagging Measure On Table option it is possible to display on the diagram the measurement in the
frequency ranges of the slices that include all the points of the frequencies list (Fig. D.86).

85 AFJFFT3110 - ver 1.65

- X
File Tools TestTools 7
Setup  Run Test Analyze  Generator Report
Manual Settings
Start Frequency 7 i He v [ Pesk [ QPeak [ CAVG [J Peak Averagng | 4 : Automatic attenuator count: 0 [0dB Att]
Stop Frequency | 1000000000 W~ L] Maxtiod N A Generator ON
M On, Tabl
AMtenustors  Input Offsst  Meas Timelms)  Artenina / Probe Cable Ampl / At RFInput Fiter 30MHz-1GHz B e
0dB - |Auto 1,000 = |-none- ~|-none - ~ | -none - vllea vz | Start
ID Freq PK QP CAVG
1 55988000 1406 924 200
2 100,000,000 4993 4981 4981
3 185,988,000 14.70| 9.39 2.14
4 253988000 1426 910 1.85

Addwith cick | ADDROW | | DELROW Clear
SAVETOFILE || LOADAFILE Update al Table
[ Show Single Slice (Row select) [ Set Analyzed Freq
Test Infa —
Test [Test Number 9 | Cond. | | spec: | | Peak
Operator |1 | Date [23/05/2022 03 2 Note [ 185.0000005MHz
Workspace | Workspace | Tests Saved Number | 9| Connection | LAN | Status |00 | Thursday, November 24, 2022

Fig. D.86: Measure On Table
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Further than the numerical indication of the table on the right side of the Analyze box, during real time
measurement it is also possible to check the measured signal amplitude at the selected frequencies
through waterfall visualization (Fig. D.87). To obtain the waterfall visualization it is necessary to move
down the cursor indicated on the red rectangle on Fig. D.87. Moving up and down the same cursor it is
possible to adjust the visualization dimensions of both diagrams (waterfall and frequency sweep).

D.4.2 ¢ THE REAL TIME VISUALIZATION

Joit i
i |
"

e

il
il “’WJJLWW \i"’ms
*JM“

Test Info —

Test Cond Spec

Operator Date (09/07/2014 10.23 Note

Workspace New Workspace Operating Mode  FFT SCAN Tests Saved Number 13

Fig. D.87: Waterfall visualization

With mouse right-click on the lower part of the graphic, it is possible to select one of the FFT bands of the

whole frequency range and the real time measurement will be performed into the selected single FFT
band.

Pushing “ALL” button, the real time measurement will be performed into the whole frequency range.
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D.5 ¢ CW GENERATOR BOX

CW Generator is the so-called Internal Signal Generator Box. It is depicted in Fig. D.88.

File  Tools 7

Setup | Fun Test | Analyze | Generator | Calib | Report

CW Generator

Frequency Amplitude
30,000,000 :| Hz 50.0 dBpv

Step

ﬁ 5000 |- ﬁ 7| RF ON

Workspace ‘Workspace Operaling Mode  FFT SCAN Tests Saved Number 304 Connection  LAaMN Status

2 AF FFT3030 - ver 1.20Beta EI@

Fig. D.88: CW Generator Box

The CW Generator has to be activated by checking flag RF ON after setting the frequency and the

amplitude.

The operator can quickly increase / decrease the value of the frequency according to the set frequency

step pushing the black arrows.
The Amplitude range is:

— from +50 dBuV to +90 dBuV for the Frequency range from 9 kHz to 110 MHz for FFT 3110 EMI

receiver (it is available the option to extend the frequency range from 9 kHz to 1000 MHz);

— from +50 dBuV to +90 dBuV for the Frequency range from 30 MHz to 110 MHz for FFT 3100 EMI

receiver (it is available the option to extend the frequency range from 30 MHz to 1000 MHz).
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SECTION E: REPORT AND APPLICATION NOTES
E.1 e« REPORT BOX

The Report box of the cockpit is the place you can summarize your test results in a form suitable for
reporting and presentation (Fig. E.1).

85| AFJFFT3110 - ver 1.50 - m} X
File  Teols

Setup  Run Test  Analyze Generstor Report

Report Options [ Insert Image [ Insert Image [ Insert Image

Report Title !AFJ FFT3110 Report

Comment Row 2 iReport Comment 2

Comment Row 1 QReport Comment 1 i
|

Comment Row 3 | Report Comment 3

Show Date and Time Show Subrange Settings

Clear Load Clear Load

Load Test

Peak Search

82|

Workspace iWDl‘(spaca

Tests Saved Number !

Reset Zoom

Connection |

LAN

Export Data

1 Status !

TestSummary -
Test Name | Test Number 62 Operator |3 ‘ Dale 2021 01.4 Operating Mode [FFT SCAN |
Cond. ‘ Spec. ‘ Automation  |-none-

Generate Report

Fig. E.1: The Report Box

In the Report box you can Load Test, make a Peak Search, Reset Zoom (if any), Export Data and
Generate Report (see next paragraph E.2).
Load Test will open the well-known Test Management table (Fig. E.2).

& Test Management
Fiter
Test Name Operator I
| Gear Fiter |
Test Name Date Operator %ﬂi’:“”g Max Hold Spechication Condtions

Test Number 1| 23/10/2013 1420 | M. Mozzi FFT SCAN CISPR 11

Test Number2 | 23/10/2013 14:37 | M. Moz FFT SCAN CISPR 11

Test Number 3 | 28/10/2013 16:10 | M. Maza FFT SCAN CISPR 22

Test Number 4 | 14/02/2014 1021 | M. Mozzi FFT SCAN ] CISPR 11

.y R A
| Te: |F |C 5 1] |
: - 0

Test info
Test Name  Test Number 5 Date Operating Mode  FFT SCAN
Operator M. Mozzi Conditions Specification CISPR 22
Test Note
Automation  -none- Setting
Show Settings
Load ‘ Save Modifications | Debse o Close: ‘
Tests

Fig. E.2: Test Management in Report box
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Here you can Load/delete a Test and Save Modifications to it, as usual. Pressing the Show Settings
button, a summary of Test Settings is presented as a Table, with all information about measurement

settings (Fig. E.3).

Test Settings &
Trace 1 Detector Trace 2 Detector Trace 3 Detector
0 -1 -1
Fstart Fstop Fstep Bandwidth {{g}e RF Input Atenuator Antenna / Pobe  Cable Ampl / At
9 000 0000 46 B 00 |
150.000 30,000,000 3kHz %Hz

Fig. E.3: Test Settings in Report box

Remember that you can customize the Report Options information, under the menu:

Tools => Customize => Report.

A window summarizing the following information is apparent:

Title

Comment 1 to Comment 3
Show Date and Time
Show Subrange Settings

Add a title to your Report

Add three lines of comments to your Report
Add current date and time to your Report
Add subrange information to your Report

See Fig. E.5 for details.

Repaort Options

Report Title
AFJ FFT3010 Report

Commerts

Report Comment 1
Report Comment 2
Report Comment 3

Show Date and Time
Show Subrange Settings

Fig. E.4: Report Options window

E.2 e GENERATE A REPORT

Once you have loaded a test and set all your supplementary information, you can easily generate a report

by pressing the Generate Report button.
After a few instants a window opens with your customized test report (Fig. E.5).

Here you can make many actions as

Export Export as an Excel, PDF and Word file
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@' Report — a *
KK of 1 D & B @ H- | 100% . Find | Next
AFJ FFT3110 Report -
Report Test: Test Number9 WorkSpace: Workspace

Report Comment 1
Report Comment 2

Report Comment 3

[Test Summary
WorkSpace Workspace Test Name Test Number 9
Laboratory LabName Date 23/09/2022 03.23
DUT new dut Operator 1
Company CompanyName Test Type FFT SCAN
Model new model Specification
Serial Condition
Note
Unit:
Autom. -none- Setting Neutral

Seftings SubRange Summary [

Range Number: 1

Start Freq.: 30.000.000Hz Stop Freq.: 1,000,000,000Hz Step: 24kHz
Trace 1: Peak Trace 2: Trace 3:
Bandwidth: 120kHz Measurment Time: 10 ms Attenuator: 0 dB
Antenna/Probe: - none - Cable: -none - Amplifier/Atten.: - none -
v
< >

Fig. E.5A: Report window (Page 1/ 2)

85! Report - O X
1 of 1 % |dn B A W~ | 100% - Find | Next
A
—_ 100 O T es0z)-OP-§iass A @how
20
80
70
80
80
40 I
30

30,000,000 100,000,000 1,000,000,000
Frequency Hz
31232023 5:04:41 PM - Report ver. 1.3
v
< >

Fig. E.5B: Report window (Page 2 / 2)

In the headings you can navigate on different pages, print on paper, choose a print layout, see the page
setup for different paper-format, and save it as a file: PDF, Excel and Word file are allowed (Fig. E.7).

3

.@.A_] '-'*T ﬂl‘j i d i of 3 4] | 1 of 3 b 'f,.

Prink Layout
| 2 Q|- 100 -

Excel
PDF
Ward

Fig. E.7: Navigation, Print, Print layout, Export as Excel / PDF / Word file

Report can be opened in Word (any version), see next pages.
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B2

AFJ FFT3110 Report
Report Test: Test Number 9 WorkSpace: AFJ EMI Test Lab

Test Summary |

WorkSpace AFJ EMI Test Lab Test Name Test Number 9
Laboratory LabName Date 23/09/2022 03.23
DUT LED Device Operator 1
Company AFJ Test Type FFT SCAN
Model 100-240V Specification
220V_L2
Serial 123ABC Condition
None
Note
Unit: dBuV
Autom. -none- Setting Neutral

Settings SubRange Summary |

Range 1
Number:
Start Freq.: 30,000,000Hz Stop 1,000,000,000Hz Step: 24kHz
Freq.:
Trace 1: Peak Trace 2: -- Trace 3: --
Bandwidth: 120kHz Measurement 10 ms Attenuator: 0dB
Time:
Antenna/Probe: - none - Cable: - none - Amplifier/Atten.: - none -
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100

Limit 1: EN&E02P-

QP-lass

A @O

dBuV
o0
a0
TO
60
50
40 |
30 .
20 : | ;
mW#«AMMMMMW
o
-10
-20
-30
30,000, 000 100, GO0, 000 1,000, GO0, 000D
Frequency Hz
ID | Frequency | Probe | Cable | Atten. | Detector | Meter | Meas Limit 1| Limit | Limit | Limit| P/F
Read | Level 1 2 2
Dist. Dist.
MU MHz dB dB dB Type dBuV | dBuV |dBuV| dB |[dBuV| dB |P/F
6 | 89.972MHz Peak | 55.96 [55.96 | 40.0 | 16.0 F
1 1368.628MHz Peak | 39.42 |39.42|47.00]| -7.58 P
2 | 92.164MHz Peak | 27.30 | 27.30|40.00|-12.70 P
3 | 98.652MHz Peak 19.55 | 19.55 | 40.00 [-20.45 P
4 |737.284MHz Peak | 24.67 |24.67 |47.00|-22.33 P
5 1921.588MHz Peak | 22.91|22.91|47.00|-24.09 P
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CISPR 16-1-1 Instrumentation; 8
CISPR 16-1-1 Receiver; 9
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Filter; 47
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Manufacturer Declaration Of Conformity; 6; 7
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Max Hold; 70; 80
—N—

NVM; 21

—0—

Operating Modes; 48

Optional Accessories; 16
Overload Factor; 13
—pP—

PAT 20M Attenuator & Pulse Limiter; 15
Peak detector; 9
Peak+Quasi Peak; 48
Prevention & Safety Note; 21
PRF; 11

Product Structure & Modular Approach; 16
—Q—

Quasi Peak; 11

—R—

Rear Panel Connections; 20
Return Procedure; 5

RMA; 5

Run Test Box; 66

—S—

Setup Box; 45; 46; 48
spectrum analyser; 9
Sweep; 48; 67

SyA Script; 50

System Automation; 49; 50
System Requirements; 21
—T—

Test Info; 71; 72; 80
Tracking generator; 19
—V—

Van Der Hoodfen; 16
VSWR; 13

—W—

Warranty; 4

Windows™ §; 21
Windows™ 10; 21

Working Conditions; 5
Workspace; 46; 47

—X—

XML; 53; 54

—7—

Zoom; 69; 77
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